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Preface

This manual describes the main functionality delivered by the CATIA Teamcenter
Interface (CMI RII) and includes the creation, storage, modification, and management of
CATIA models and assembly structures in the Teamcenter PDM system.

]
About this Manual
This manual is intended for end users of the CATIA Teamcenter Interface. It assumes that

the reader is familiar with the CATIA application and with Teamcenter Rich Client.

]
Related Documents

The following manuals contain information about installation, usage and customization of
the CATIA Teamcenter Interface:

Manual Title Version

CATIA Teamcenter Interface RIl Installation Manual 2.2

CATIA Teamcenter Interface RIl User Manual 2.2
]

Organization

This manual contains the following chapters:

Chapter 1 provides basic information about the CATIA Teamcenter Interface and
describes some features of this application interface.

Chapter 2 describes how to start CATIA within the Teamcenter environment and also how
to enable the CMI functionality within CATIA V5.

Chapter 3 introduces the CMI RII Application with a general explanation and then by
listing its functions. The goal of this chapter is to make the user familiar with this
component. The CMI RIl Application functions will be explained in subsequent chapters.

Chapter 4 describes how to handle CATIA relevant data in Teamcenter.
Chapter 5 explains how to work with CATIA V5.

Glossary contains the CATIA Teamcenter Interface terminology.
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Conventions Used in this Manual

This font

ltem 1->ltem 2

!

™

/-
»
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¥

Is used for document titles and emphasis.

Is used to identify a menu path to reach a specific function.

This icon is used to identify Teamcenter related sections and actions.

This icon is used to identify CATIA V5 related sections and actions.

Your Comments are Welcome

Please feel free to tell us your opinion; we are always interested in improving our
publications. Mail your comments to:

T-Systems International GmbH
Solution Center PLM
Fasanenweg 5

70771 Leinfelden-Echterdingen
Germany

E-mail: cmi_support@t-systems.com
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CHAPTER 1

Overview

This chapter provides basic information about the CATIA Teamcenter Interface and lists
some features of this application interface.

]

Introducing CMI (CATIA Teamcenter Interface)
The CATIA Teamcenter Interface (CMI RII) was developed by T-Systems as a high-end
integration between the CAD system CATIA V5 and the PDM system Teamcenter. With

this interface it is possible to manage CATIA V4 and CATIA V5 models and assemblies in
Teamcenter and CATIA V5.

CATIA V5 uses assemblies similar to Teamcenter. CMI RII makes a bidirectional mapping
between the Teamcenter structure and the CATIA V5 structure. So users have the full
functionality of Teamcenter and CATIA V5.

]

CMIRIljoins the advantages of CAD with PDM
The CATIA Teamcenter Interface combines the CAD Excellency of CATIA with the power
of the PDM system Teamcenter. It provides the user with a more sophisticated way of

working with CATIA by allowing the management of product structures and multiple level
assembly structures within the PDM system.

The CATIA Teamcenter Interface (CMI RII) permits:
= Integration of CATIA data in workflow (e.g. release control);

= Management of CATIA data in vaults, without knowledge about the underlying file
system;

= Updating concurrent engineering processes by different users;
= Distribution of CATIA data in a network;

= Simultaneous management of CATIA data and structures;

= Construction of part structures within Teamcenter;

= Modification of the position of the structures;

= Search for CATIA data by different attributes.
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CMI Architecture

The following figure explains the architectural basics of the CATIA Teamcenter Interface

(CMI RII).
CMI RII Application in Teamcenter CATIA V5 with CMI RII
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Figure 1: CATIA Teamcenter Interface architecture

The user can expand an assembly within the CMI RII Application and send this assembly
to CATIA V5. After changing geometries and/or positions in CATIA the user can update
the assembly in Teamcenter.
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CHAPTER 2

Getting Started

This chapter describes how to start CATIA within the Teamcenter environment and also
how to enable the CMI functionality within CATIA V5.

Assumptions

Some assumptions, for a better understanding of the descriptions and examples:
CATIA V5 should display the CMI toolbar:

L 68 A EXESEBALBDT 4

UNIX:
Start CATIA V5 with the command cmicatstart.sh

Windows:

Make sure you have set up the right environment (refer to Installation and
Administration Guide). Launch CATIA V5 with the command:

CNEXT.exe -env CatiaCMIEnv -direnv "C:\<path to the CMIEnv>"

]

Starting Applications
Before working with CMI RII it is necessary to start the Teamcenter Rich Client, the
Teamcenter user interface, and the CATIA V5.

For information on starting Teamcenter Rich Client see the Teamcenter Help Library —
Getting Started with Teamcenter provided by Siemens PLM.

For information on starting the CATIA User Interface see the CATIA Solutions User’s
Guide.

AR If the CMI toolbar is not in the list of toolbars, a problem with the installation may -
have occurred. In this case, contact the administrator. Information about this kind of :
: problem can be found in the Installation Manual. '
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CHAPTER 3

The CMI RII Application

This chapter introduces the CMI RII application with a general explanation and then by
listing its functions. The goal of this chapter is to make the user familiar with this
component. The CMI RIl application functions will be explained in subsequent chapters.

I
What is the CMI RIl Application?

The CMI RII application is a Teamcenter application used to interactively prepare an
assembly structure for sending to CATIA and to provide several manipulation facilities for
the CMI commands found in CATIA. The entire data interchange between Teamcenter
and CATIA is achieved via the CMI RIl application.

CMI RIl defines some new dataset types in Teamcenter that can be used to manage
CATIA V5 files (CATPart, model, cgr, CATProduct, and CATDrawing). The management
of CATIA V5 files is described in Chapter 5.

¥ - The CMI RII application has to be started in Teamcenter before you can call the
-functions of CMI RII.

To start the CMI RIl application use the standard Teamcenter start mechanism as shown
in Figure 2.

=lox|
Flle Edit ‘Window Help

IR & oo * TEAMCENTER

E Bk o @ P

Getting Starte

Search

Enter ltem IDtose. [ -

~ QuickLinks - o

&4 Getting started 5%

ERHoms » @ Teamcenter 8

My Wiorkist »

&My saved Searches > ‘Welcome to Teamcenter 8 - Opening your world to shared data and enabling communication across your
Gy Links » organization,

4 | To begin, you can:

} Open Items
- Search for data to begin your work

» History

- Start an application in the navigation bar on the left
} Favorites Grganize

- Select a link from below
- IWant Tou. o omioe

We hope you enjoy your experience with Teamcenter, We look forward to serving your data
rmanagement needs.

Find a part and begin my wark: [Enter Tem ID to ssarch 8-

Open by Teamcenter or Warklist

‘V, Getting Started ||
f[mm] ] VIEW Edit a product struchure

[y Teamcenter (’_‘ Wigwr [ Edit iy carpany's classification data
Structure Manager
& % =g »

LoadingGetting Started... a

Figure 2: Teamcenter Rich Client start window
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A window with the CMI RII application will appear after logging in in the PDM system

Teamcenter (see Figure 3).

EPCMIRI - Teamcenter &

File Edt Tools Window Help

@7 CMIRIT ¢ o 07) - Engineering/Designer  [IMC-516457144] )

Search A cmen 3

(Rl =Rl Rl TEAMCENTER

=18ix]

[engine - Hame | Item 1d | Revision | Occurrence Name |

= Quicklinks (o

LBHome »
iy worklist »
|2 My Saved Searches %
ety Links »

» Open Items
b History
» Favorites Organize

» IWant To.. Customize

&) Getting started
& cmian
My Teamcenter
Structure Manager
&% Flg i » I al
Ready 2X%dd®O | J0

Figure 3: CMI RIl application window

I
The CMI RII Application Menu

Below the CMI RII application menu items will be described.

File Edit Tools Window Help
|8 RD | ®

Figure 4: CMI RIl application menu items

Menu item File
File Edit Tools ‘Window Help

Clase

&Iy Exit

Figure 5: CMI RIl application menu ‘File’

The menu item File 2Close will close the CMI RII application.

The menu item File 2Exit will exit the Rich Client application.

Menu item Edit

File | Edit Tools ‘wWindow Help
-Cupy Zhr| =

O User Setting. ..
£ options. ..

Figure 6: CMI RIl application menu ‘Edit’

The menu item Edit 2User Setting ... will open the User Setting dialog of the Rich Client

application.
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Menu item Tools

The menu item Edit 2Options ... will open the Preferences dialog of the Rich Client
application.

The CMI RII preferences show the CMI RII options (see Figure 7).

= Send Drawings To CATIA
Checked if drawings (CATDrawing) should be sent to CATIA.

= Transfer CGR files To CATIA
- No No CGR are sent to CATIA
- Only CGR Only CGR are sent to CATIA
- CGR + geometry CGR and geometry files are sent to CATIA

=  Work with CATIA Version

- V5 work with CATIA V5
-V4 work with CATIA V4
=
J Ophs . = Send Drawings To CATIA =
E‘Ell ’VI- Send drawings to CATIA?
!

~Transfer CGR files To CATIA

] Ttem Revision = Mo
- CheckIn/CheckOut

] 1dentifier  only CaR
Calendar ~ CGR + geometry
[T start OF Week
H 7] Default Base Calendar Work with CATIA Yersion
B Multi-Site Collaboration &g

C L.Cmem hd | RIESE )
o 2

Options | Index | Search | Organization

[a]4 | Apply I Cancel |

Figure 7: The CMI RIl application options dialog

File Edit | Taols Window Help
| £ 85 B sendTacaTiA |
Tenmp o CaTIA
Imserk: Tio EATIE
Cance] CATLE Ackion
[ Clear Warkbench

Figure 8: CMI RIl application menu ‘Tools’

The menu item Tools 2 Send To CATIA starts the Read To CATIA Action and will read
the CMI RII application content to the CATIA.

The menu item Tools=> Temp To CATIA starts the Add Temp To CATIA Action and will
read the temporary added items to the CATIA. This menu item is only usable if the Add
Temp action is started from the CATIA.

The menu item Tools 2Insert To CATIA starts the Insert To CATIA Action and will read
the queried items to the CATIA. This menu item is only usable if the Insert from
Teamcenter action is started from the CATIA.

The menu item Tools2Cancel CATIA Action cancels actions which are started from
CATIA. (e.g. SaveAs and AddTemp). This menu item is only usable if an action is started
from the CATIA (e.g. SaveAs and AddTemp).

The menu item Tools 2Clear Workbench removes all items from the CMI RII application
window.

CMI RII User Manual 7



Menu item Window

File Edit Taals | wWindow Help

J &) Z- &  Open Perspective
Show Wiew J

Save Perspective As..,
Reset Perspective
Close Perspeckive

Preferences. ..

v Mavigation Pane

v Toolbar

Figure 9: CMI RIl application menu ‘Window’

The menu item Window includes the standard menu items provided by the Teamcenter
Rich Client application.

Menu item Help

File Edit Tools ‘Window | Help

J EEDSDERD J @) Current Application  F1
@I Help Library Ckrl+F1
About

Software pdates r

Figure 10: CMI RIl application menu ‘Help’

The menu item Help points to the standard application Help provided by the Teamcenter
Rich Client Application.

The menu item Help 2About opens the About dialog.
The About dialog informs about the actual CMI RII application (see Figure 11).

(T —oix

/ CMI RII - The Teamcenter CATIA Integration {Yersion 2,2.00

CMI RII manages CAD product struckures and connects CATIA VS with Teamcenter,

More info more

JRE Version: 1.6.0_14
WM Available Memory: 266.47Mb

WM Free Memory: 213.71Mb

Host Mame: wp-scplmtestdll
Log File: C:ADOCUME~ 1L OCALS~1)Tempitcserver, exeb28bael, syslog
Journal File: CADOCUMER 14\ LOCALS~14 Templtcserver, exeb28bael, jnl

SI E M EN s Copyright @ 2008, 2002 by T-Systems International GmbH, Al rights reserved,
CATIA is a registered trademark of Dassault Systémes,
Teamcenter is a registered trademark of Siemens PLM Software.,

Installation Details | 0K |

Figure 11: CMI RIl application About dialog.
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Pop-Up menus of CMIRIl items

If you select an Item and drop it into, or Send it to the CMI RII application, a BOMLine will
be created dynamically. Iltems which will be handled as geometry items are represented

by %4, structure elements are represented by B you select a Drawing dataset and
drop it into, or Send it to the CMI RIl application a dataset is shown in the CMI RII

application. The Drawing dataset is represented by @

ltems in the CMI RIl Application

On the Item objects displayed in the CMI RII application window there are the following
functions available:

EPCMIRI - Teamcenter &

File Edt Tools Window Help

IRl =R =R

Search

=13ix]

TEAMCENTER

IEm;lne M
v Quick Links o

B Hame »
My Worklist »
|2y My Saved Searches »
G My Links »

b Open Ttems
» History
b Favorites

Organize

» IWant To.. Customize

Occurrence Name |

& Getting Started

&7 cMirn

My Teamcenter

Structure Manager

& ¥ Een»

Ready

3 nRiodj 2 Remave from Window A Cannectionfod, 1
B % CrankshaftiaL ¢ 5 A CATIA 5 Crarkshat. 1
R crankaig 3 CrankBalt 1
W % CrankshaftLe & Exand A CrankshaftLeft, |
"V % CrankshaftRj  Erpand Belw A CrarkshaftRight. 1
5 FixedPartsfal v 'c;';:m A FixedParts.1
¥ % CylinderBiodk A CylinderBlock. 1
B P Rackitl (vie | T EIVE A Rack.1
[V By Caseldsl SendTe roA Case.1
o ] g SerewR; e e a Screw. 1
[ R Screwfa; & Screw.2
[ By Screwpe; o STt A Screw.3
[ By Screwpat Screw A Screw.4
5 -[F % PistonComplete/é; L (view)  PistonComplete A PistonComplete. |
- [F 2 Pistonfagt Piston A Piston.1
G- % pistonBoltéssm/é; L (view)  PistonBoltAssm A PistonBoltAssm. 1
7 % PistonBolt A; L PistonBolt A PistonBalt, 1
% RetainingRingj ;1 RetainingRing A Retainingrting. 1
7 % RetainingRingjA;1 RetainingRing A Retainingfting.2
| al=|
I X% REG S 0

Figure 12: Context menu on a BOMLine in the CMI RIl application

Remove from Window

Highlight in CATIA

Refresh
Expand

Expand Below
Expand Below...

Collapse Below

Copy
Send To

Properties..

Add To Favorites

Models in the CMI RIl Application

On the Dataset (CATDrawing) objects displayed in the CMI RII application window there

Removes the selected object from the CMI RII
application window.

Highlights the selected objects in CATIA.
Refreshes the selected object from the database.
Expands the object one level.

Expands the object multiple levels.

Expands the object multiple levels, a dialog will be
displayed where the level number can be defined.
Collapses all children.

Copies the selected object to the clipboard.
Sends the selected object to another Teamcenter
application.

Displays the Teamcenter properties dialog.

Adds the selected object to the favorites list on the
left.

are the following functions available:
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File Edt Tools Window Help

Search

TEAMCENTER

|Engme -
~ Quick Links Custarmize
BHome »
KMy warklist >
| & My Saved Searches 3
Sty Links »

» Open Items

» History

» Favorites Organize
P IWantTo.. e

;?} Getting Started

&7 o

My Teamcenter

Structure Manager

& e T30

Ready

A
ectiorRod s Connectionfiod. 1
* kshaft s Crankshaft,1
Kol s CrankBolt, 1
kShaftLeft s CrankShaftLeft.1
hkshaftRight s CrankshaftRight. 1
FixedParts s FicedParts.1
o F % CylinderBlock/a;1 ylinderBlack A ylinderBlock.1
= Rackif;1 {view) Rack A Rack. 1
b [ % Casefiit Case A Case.l
b [ % Sarewfa;t Screw A Screw 1
e[ Screwfagl Screw n Screw.2
e[ Screwfagl Screw n Screw.3
e [F 8 Screwfagl Screw n Screw.4
=P % PistonComplete/A;1 (view) PistonComplets ) PistonComplete, 1
& Piston/a;1 Pistan a Fistan. 1
4 PistonBoltAssm/A; 1 (view)  PistonBoltassm A PistonBaltassm. 1
- % PistonBalt/a; 1 PistonBolt a Pistongalt.
-7 % RetaningRingfA;1 RetainingRing B RetainingRing.
IV % RetainingRingié; 1 RetainingRing A RetainingRing.2

Item Id Revisian Qccurrence Name

| al=|

X% Q| D0

Figure 13: Context menu on a Dataset in the CMI RIl application

Remove from Window

Copy
Send To

Properties...

Add To Favorites

Removes the selected object from the CMI RII
application window.

Copies the selected object to the clipboard.

Sends the selected object to another Teamcenter
application.

Displays the Teamcenter properties dialog.

Adds the selected object to the favorites list on the
left.
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Enhancements in the Structure
Manager Application

This section introduces the enhancements in the Structure Manager Application by listing
its functions.

CMIRII Menu bar in the Structure Manager Application

The Structure Manager application menu is enhanced by a new CMI — RIl menu item
(Figure 14).

File Edit Wiew CMI-RII Tools ‘Window Help

Figure 14: Structure Manager application with CMI RIl menu

Menu item CMI-RII

The menu item CMI — RII (Figure 15) contains two commands to send data to CATIA.

File Edit Wiew | CMI-RII Tools ‘window Help
&7 Send To CATIA
&) Send DMU To CATIA

Figure 15: Structure Manager menu ‘CMI - RII’

CMI-RII->Send ToCATIA

The menu item CMI — RIl 2 Send To CATIA will send the expanded Structure Manager
content to CATIA.

F- The Send To CATIA command will send the content of the current active Structure
— Manager application window to CATIA. Only expanded structures will be sent to
CATIA. Unexpanded structures will not be sent to CATIA.

[3Psructime mmnger - Teamcenter® =loix
Fle Bt Vew | OMI-RID Took Widos el

TEAMCENTER

| ] e B To CATEA % L e | g FIRRFL DO GA LN

= Ll L]
Enana [ R [ S —

Ll Cust DotiLie [ skt Transforma,.|
BBy rere » S EnganeiA; 10000100001 ...
-y ! e
Gy st
L6111y Savec e W
oy ks »

Dpen Thenn

B ngnels1 ()

S o

TR | [ —"

Ry

Fregrmy = o]
Figure 16: Structure Manager application with Send To CATIA command
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Only the expanded structures from the example structure in Figure 16 will be sent to
CATIA. The selected items FixedParts and PistonComplete are not expanded and the
substructures of these items are not sent to CATIA.

CMI—RII->Send DMU To CATIA

&

The menu item CMI — Rl 2Send DMU To CATIA will send the DMU ‘marked’ Structure
Manager content to CATIA.

The Send DMU To CATIA command will send the checked content (checkboxes are
presented by the viewer functionality) of the current active Structure Manager
application window to CATIA. Only checked structures will be sent to CATIA.
Unchecked structures will not be sent to CATIA.

&P 5tructure Manager - Teamcenter 8 =101 x|

File Edit View | cMI-RII Graphics Tools Window Help
I IRl
el

* " structure

TEAMCENTER

qEAU MO PH

57144])

Search [#] Structure Manager 53 =0
IEngme M ‘Englr\eﬂA;l(v\ew)-Latestwovkmg-Date-"Now” | iz %
~ Quicklinks ¢y cromize S, Supersedure | attachments
EHome » [7 % “. Enginefa;1 (view) @) variants o Viewer | ) Referencers
My Warklist 5 [ & ) ConnectionRod/#;1  ConnectionRod. 1 =3
B %4 Crankshaft/a1 (vi... Crankshaft,1 E"-‘ XEaE oo ‘?ITY' [
|2 My Saved Searches 5 L
@ iy ke » S ) CrankBolfa;l  CrankBok.d
71 % ¥ Crankshaftleft... CrankShaftLeft,1
J2 % 0 CrankshaftRig... CrankshaftRight.1
~ Open Items =2 1 yiee FixedParts 1
% Enginedi1 (view) [ %7 CylinderBlackya; 1 CylinderBlock.1
=[] 4, Rack/8;1 (view) Rack.1
Sl Casefiil Caseld
w7 W0 Serewfail Serew.1
~ History co 7] 00 Screwfail Screw.Z
T Screwfasl Screw.3
& Getting Started LT screwial Sorew.d
B[ % %, FistorComplete/a;... PistonCamplete. 1
’( CMIRII [T 0 Pistanya 1 Piston, 1
=[] % “, FistonBoltassm... PistorBoltAssm. 1
My Teamcenter L[] %0 PistonBolt/. . PistorEalt. 1
= L7 2 RetainingR. .. RetainingRing. 1
Chicbimelanadey %70 RekainingR... RetainingRing 2

T T — 2

Ready IX%d WO | _J0

Figure 17: Structure Manager application with Send DMU To CATIA command

Only the checked items from the example structure in Figure 17 will be sent to CATIA. The
unchecked structures FixedParts and PistonComplete will not be sent to CATIA.

12

CMI RII User Manual



Enhancements in the
My Teamcenter Application

This section introduces the enhancements in the My Teamcenter application by listing its
functions.

CMI RII Menu bar in the My Teamcenter Application

The My Teamcenter application menu is enhanced by a new CMI — RIl menu item (Figure
18).

File Edit Wiew CMI-RII Translation Tools ‘Window Help

Figure 18: My Teamcenter application with CMI RIl menu

Menu item CMI-RII

The Menu item CMI — RII (Figure 19) contains a command to send data to CATIA.

File Edit  Wigw | CMI-RII Translation Tools Swindow  Help
£7 Send To CATIA

Figure 19: My Teamcenter menu ‘CMI - RIP’

CMI-RII=>Send To CATIA
The menu item CMI — RIl Send To CATIA will send the selected My Teamcenter objects

DMy Teamcenter - Teamcenter & _olx|
File Edit view ls window Help
= = = E AL E
RSB S] | 5o TolcaTia 5 A= Q TEAMCENTER
Search 3 ooooosia 83 .7t T O[> Summary 52 [ Details | 2o Viewer | ™ Impact Analysis| % ITPreview| = O
Enter ltem ID to seard £ - (2 = = i e
L EL
- auckinks ey | ESEETN | | 000006, /A oy
B Home » ~ Properties ~azl
My Worklist »
My Projects » biect: [ooo00e/A
By Links »
(& My Saved Searches Mame: [noo0os/a =] -
[ =
~ Open Items —
2 Dataset... (3) Description: =l Sel
. Dataset... (2) =l
4 Dataset... (1)
’.\A::HETe) Ownert § k2007 (re2007) w
Q Getting Started GraupID: iy Engineering ¥
f CMI RIT Last Modifying User: 8 k2007 (te2007)
My Teamcenter Chededout: [~ L
Structure Manager Checked OutBy: (5l Hio Value
& ® T o» 4 [ _’l_l
Ready 72 LN Y R o

Figure 20: My Teamcenter application

F-) The Send To CATIA command will send the selected objects (see Figure 20) of the

- current active My Teamcenter application window to CATIA. Only CATDrawings are
supported now.

CMI RII User Manual
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CHAPTER 4

CATIA
Teamc

relevant Objects in
enter

This chapter describes how to handle CATIA relevant data in Teamcenter.

Predefined Object Structure

The CATIA Teamcenter Interface (CMI RII) uses the following predefined object structure

for CATProducts.

WMy Teamcenter - Teamcenter 8 =1 S|

File Edit Yiew CMI-RIL Translson Tools Window Help

SN

| 0| % i@ x

TEAMCENTER

=) My Teamcenter

Summary 22 (=] Details wvwewev}"‘ ImpactAr\a\ys\s] = JTPrewew] =0
Qo BEEY S dE
kY a0l & Item001 /A
[# memoot & / Sunmal
B Trem0L -view = Properties -
Pt % Iem001/a;1
[ Temonija Obiect: [Tremont/a
B B[] TemD01 fA-view
& et L4 Marve! [ Tremonija =
&) eemantja = -
PR TIEmE ® @Itemnm.w —
M (5 view Description: [Tremnnt ia =] el
L] 55 Named References x| -
»Fa £ |l
oo | Reference | Name [ see [ Remate | Tyee Last Modfied | volume |
e |CaTProduct [ttema01.CATPraduct | 15 Kb| [tmanFile: 30-2ul-2009 1256 volumel |
2
Open Tmport .. Expart.. _Iv"ﬂ' _|‘1‘ _I*J _|x
_>l_I

Ready

X% FhEyG 2 o

An Item Revision has a Dataset attached of the type CMIStructure. The Dataset has

Figure 21: Predefined CATProduct object structure

exactly one Named Reference of the type CATProduct. This will be loaded to CATIA as a

CATProduct.

‘'~ CIfno Dataset is attached to the Item Revision, a new Product is created in CATIA

) Q “with the Read operation.

CMI RII User Manual
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| WMy Teamcenter - Teamcenter 8 =lolx]
File Edt Yiew CMI-RIL Transk ol Window  Help
I ) \ %D ‘u| x Jib TEAMCENTER
Search Summmary 53[5 Detals | 7 Viewer | ™"/ Tmpact analysis| % JTPrev\aw] =0
Trem0L - Pl =
~ Quick Li B &
QuickLinks ¢ omgs | B 155 om0t &l [tem001 /A Summary
[ temant
A% Hame ) » u{gltemum ~view ~ Praperties -
Kty Worklis: » B TtemooLfas1
Edmy Projects » [ Tremonija Object: [Ttemoo1fa
By Links » ® off Rem0o1ja-view
[y Saved Searches & remont. 118 Mame: [Tremontja =] 4
& emontia = [=
PTOpeRIIans # f o001, 114 —
[ view Description: [Tremnint iz =] Sel
¥ Hit [T ——" al x| -
»Fa b w=
oo | Reference | Name [ see [ Remote | Type Last Modfied | volme |
fe [CaTProduct [Item001.CATProduct | 15Kb| [ImanFile 30-1ul-2009 12:55  |volumel |
&
Open Import. .. EXpert.. x| & 5 x|
_»IJ
Ready XS MRG 2 0

Figure 22: Predefined CATPart object structure

An Item Revision has a Dataset attached of the type CMI3DGeo. The Dataset has exactly
one Named Reference of the type CATPart. This will be loaded to CATIA as a CATPart.

V. If an empty Dataset of the type CMI3DGeo is attached to the Item Revision, a new
:CATPart is created in CATIA with the Read operation.

-~ :Named References of the type CMI3DGeo can handle references of the type model
-and cgr which will be loaded in CATIA with the Read operation. .

“‘model’ is used for V4 CATIA model files.

‘cgr’ is used for light geometry representation files.

Working with Structures

A structure is made of one or more items.

An item can contain other items.

Creating an Item
F-) In a Teamcenter Rich Client (e.g. My Teamcenter or Structure Manager application)
select FHie>New->ttem...

The Item creation wizard is started and guides you through the Item Creation Process.

Searching for items

ﬁ) In a Teamcenter Rich Client (e.g. My Teamcenter application) press the @
button.

In the Search window use the Predefined Search for Items. The result is displayed in the
My Teamcenter application.

Creating a Structure
To create or modify a structure in Teamcenter use the Structure Manager application.
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The figure below shows an example assembly with expanded items in the Structure
Manager application browser.

P structure Manager - Teamcenter & [l
File Edt View CMI-RI Took Window Help
=l P B ) > | q
(1 SRR R A A = = A T A - = TEAMCENTER
“ Structure Manager ) =
Search [ Structure Manager £3 =a
|E”te'ng”‘]m”m'd | Engine/i;1 (view) - Latest Working - Date - "Now" O & o
¥ Quicklinks — cypomize EQMLine | Item Id | occurrence Hame |
> "
BHeme » 5 Enginea; L (ven) Engine
Gty okt » S % ConnectionRod{a;1 ConnectionRod ConnectionRod. 1
b ¥ S aearch 5 % Crankshaftia;1 (view) Crankshaft Crankshaft.1
va Saved Searches 3 LB CrankBolia; 1 CrankBolt CrankBolt.1
My Links % CrankShaftleftfi L CrankShaftleft Crankshaftleft. |
<% CrankshaftRight ;1 CrankshaftRight CrankshaftRight.1
+ Open Ttems b FixedPartsia;1 (view) FixedParts FixedParts.1
% Engineia; 1 (view) % CylinderBlockfa; L CylinderBlock CylinderBlack. 1
B Rackja; 1 {view) Rack Rack.1
L Caselil Case Case.l
o Serenifgl Sarew Serew. 1
* History oy Screvlyl Screw Screw.2
% Iremaodia o Serewifyl Screw Screw.3
L Screvniagt Screwv Screw. 4
‘:2 Getting Started % PistonCompleteia; 1 (visn) PistonComplete PistonCompiete. 1
o Piston/i; L Pistan Piston, 1
’( CMIRIT = FistorBoltAssmiA;1 (... PistanBolkAssm FistonBoltAssm, 1
wo P PistaniBoltia;l PistonBok FistonBol:, 1
{5 My Teamcenter % RetainingRing/A; 1 RetainingRing RetairingRing. 1
- % RetainingRing/A;1  RetainingRing RetairingRing.2
Structure Manager
ge@e o> ||MelEdel #[4)
Ready X% dh®mO | S0

Figure 23: Example of an expanded assembly in Teamcenter Structure Manager
application

Example Structure for CMI

The following instructions describe step by step how to create an example assembly
structure which can then be loaded into the CATIA session:

E) Start the Structure Manager application in Teamcenter Rich Client (Figure 24).
==

P structure Manager - Teamcenter 8 oy =] 3

File Edit ¥iew CMI-RI Tools \indow Help

I RE A TEAMCENTER
B8 EAHACr N

|G| 2> e 2l R(EF0| BT
()

“ Structure Manager ( . 41)

Search [7] structure Manager 53 =0
000100 E - - .
I Ho structure - Latest Working - Date - "Now® 0 &
¥ Quick Links  ¢gromize BOM Line | Item hlame Occurrence Name
BHome »
My Worklist »
[CLmy Saved Searches
My Links »

~ Open Ttems
0001004;1-Table

~ History

& Getting Started

; CMIRIT

{1} My Teamcenter

Structure Manager

PPN e =T ) —— |

Ready ? X% gd B0l

Figure 24: Empty Teamcenter Structure Manager application

E) Create a new item named “Table” with File 2New 2Item...
—J
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M

structure Manager - Teamcenter 8

File Edit view CMI-RII Tools ‘Window Help
IR B[ %o ]
|2 R e || el POy T

Search

=

TEAMCENTER

|000100 B

~ QuickLinks oo Oceurrence Hame
3 Home »
My Worklist »
|24 My Saved Searches 3
& wy Links »

~ Open Items
% 000100/8;1-Table

~ History

g‘} Getting Started

; CMI RIT

{55 My Teamcenter

Structure Manager

BT SR —

Ready

X gnEg e o

Figure 25: Structure Manager application with “Table”

P structure Manager - Teamcenter &

File Edit View CMI-RI Tools window Help
IR [28Dn|x
[ RS = 5| &l a0 Y€

P O8N EQA W

4

Select the “Table” and create a new item named “Plate” with File 2New 2ltem...

Select the “Table” and create a new item named “Leg” with File 2New 2ltem...

=lolx|

TEAMCENTER
[

L Structure Manager | 41

search [ *Structure Manager 53 = d
|nnmnn " | 000100f;1-Table - Latest Working - Date - "how” O o
~ Quick Links Customize BOM Line Ttem Name Occurrence Hame

(B Hame »

gy worklist »

[ &My Saved Searches 3

iy Links »

~ Open Items
5 000100/%,; 1-Table (view)

~ History

@ Getting Started

; CMIRIT

15 My Teamcenter

Structure Manager

N N e o — |

Ready

I XWgFhwG 2 o

Figure 26: Structure Manager application with “Table”, “Plate”, and “Leg”

Select the “Plate”, and right click Send To My Teamcenter.
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$PMy Teamcenter - Teamcenter 8

File Edit WView CMI-RII Translation Tools Veindow

[BlEhn)x|5sda

EEN

Help

i | Q

¥ Summary 82 ] Details | @ Viewer

=10l x|

TEAMCENTER

Search ' Impact Analysis | £| IT Preview
Enter Ttem ID ko searc| - b A T
¥ Quick tinks ¢y oz #, 000101-Plate summary
[ voo1ot
B Home » % 000101 /4;1-Plate ~ Properties ~ Actions
My Worklist »
My Projects > Object: [po0101-Flate
My Links » B ooy
(£ My Saved Searches Name: =
(5], Save
» Open Items =
Description: = .
» History E sendtas |
» Favorites o %
- Qumer: L2007 (k2007 W
— e =5 000101/A; 1-Plate = <
N . B oootonja Group 10 B Enaneerng ¥
‘:} Getting Started 5 view Endingsring
rf CMI RIT Last Modifying User: C2007 (k2007 ¥
i} My Teamcenter Checked Qut:
Structure Manager Checked Out By: (%) Mo Value
& e B0 » o | »

Ready

X%t BwG 2 Do

Figure 27: My Teamcenter application with “Plate”

&

geometry.

Select the Item Revision “xxxxx/A;1 — Plate” and use the command
File 2New ->Dataset to create a new dataset of type CMI3DGeo to define a

Use the More... button on the left side to select the type CMI3DGeo.
The CMICatiaV5 Tool is set automatically.

Press the OK button to continue.

W
-,-EJ

EPrew Dataset

Marne

Tool Used

More, ..

Irnpork:

 |ooo101/a

Descripkion:

g ICMICatia'u'S "I

[~ ©pen Cn Create

04

Apply

Cancel |

Figure 28: New Dataset dialog

application.

¢ @

item with Edit>Copy.

Repeat the same procedure for the “Leg” item and switch to the Structure Manager

Select the “Leg” of the “Table” in the Structure Manager application and copy the

Select the “Table” item and paste the “Leg” item three times with Edit 2Paste.
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P Structure Manager - Teamcenter -
Structure M T ter 8 [=] 3

File Edit View CMI-RII Tools Window Help
Im & XD D ] TEAMCENTER
RS e @ & fR(ED| T 2L R TINRAN PN

Search
[oworo0 ~ || 00010078 1-Table (view) - Latest Working - Date - "How” O & =
v QuickLinks  ¢oromize ECM Line Ttem Name Occurrence Name
H » . :
g;”;:mmsl » L5 000101iA;1-Plate Plate
¥ % 00010248;1-Leg Leg
|2, My Saved Searches % 000102i8;1-Leq Leg
Qv Links » % 000102)8514eg Leg

% 000102/8;1-Leg Leg
~ Dpen Items

5 000100/4;1-Table (view)

~ History

é"), Getting Started

; CMIRIT

{11}, My Teamcenter

Structure Manager

ST SIS T m—1
Ready XL FmEmg e S

Figure 29: My Teamcenter application with complete “Table”
Check that CATIA is started with installed CMI RII.
Select the “Table” in the Structure Manager application and

right click Send To2>CMI RII.
Select the “Table” in the CMI RII application and right click Expand Below.

¢eH

File Edit Tools window Help

|lfErD | = TEAMCENTER

esigner [IMC-516457144] )

Search =04

|Enter Ttem 1D to searc| - Name: Item Id Revision Occurrence Hame
= ew) la

~ Quick Links stomee ¢ % 00010214;1-Leg 00102 a

B Home » [ % 0001024 1-Leg 000102 A

Gty wiorklist » [ % 0001024 1-Leg 000102 A

[ My Saved Searches > [ % 0001024 1-Leg 000102 A

Gy Links » o [F % 0001014 1-Plate 000101 A

» Dpen Items

» History
} Favorites Organize
» IWant To.. Customize

B Getting Started

f CMIRTI

ii5; My Teamcenter

Structure Manager

& % Flg o ‘ _IC‘_I':l

Ready X PG mwmeg e I

Figure 30: CMI RIl application with complete “Table”

‘'~ Verify that all items are checked. Only checked and expanded items will be sent to
i CATIA.

8) Use the Tools 2Send To CATIA command to send the content to CATIA.
=
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[%]CATIA ¥5 - [CMI - 000100] =10l x|

EJ Gtart  Fle Edit  Wiew [Insert  Tools CMI  fnalyze  Window  Help 1= x|

| SE8ErAsRA LT &

w
k;
BN

ST R R &S

! ‘-
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‘ 1 element selected | =N e

Figure 31: CATIA V5 with loaded “Table”

Updating a Structure

Complete construction in CATIA and press the Update button in CATIA V5.

The files in CATIA and the metadata are updated to Teamcenter.

[+]CATIA ¥5 - [000100.CATProduct] !

Bl oor Fe et vew st Dok M Ansyes 2ixIf
| £ éﬁﬁ}(ﬁé X LR crvemns [ cMidomaton |

’ItEmRevslun Item D00100/4;1-Table updated. i’

(CMIStructure Dataset 000100/A created,

(CMIStruckure Dataset 00010074 attached to Ttem 000100/4;1-Table.
(CMIStruckure object 000100/A checked out,

File 000100, CATProduct for Dataset 000100/4 uploaded.

’7CMI Operation Status

o Update Finished

 aEARE

Nes@gayese o 0 BS8s sFead’s 2,
I EE]

Select an object o a command

Figure 32: CATIA V5 with updated “Table”

& Change the visible attributes in the CMI RII application and check the values for
o Occurrence name and Matrices. Both attributes are filled with the current CATIA

data.
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Fie Edt Tools Window Help

IRl =Rl Nes TEAMCENTER

CMIRIL [t

Search
| Enter Ttem ID to seard B

Item Id Revision Qccurrence Name

= |
7 QuickLinks ostomize o010z A 000102.1
{BHome » 000102 A o00102.2
Gty worklist » 000102 a 0001023
[EL My Saved Searches 000102 a 0001024
iy Links » 000101 A 000101.1

» Open Items

b History
» Favorites Orgarize
» I'Want To... Customize

é")‘ Getting Started

’( CMI RIT

{15, My Teamcenter

Structure Manager

gL Ee 0 | E— |

X% FRRG | D1t

Ready

Figure 33: CMI RIl application with complete “Table”

8) Select the “Plate” and right click Send To My Teamcenter.
- Verify that the dataset and a named reference are added.

| SPMy Teamcenter - Teamcenter 8 = =3I

File Edt \View CMI-RII Translstion Tools Window Help
Rl Hh(x |[d0RSE 8|5 |Q TEAMCENTER

LZ)Ba ®" My Teamcentel

search ; Summary 52 \[,‘éfnetawls]wwewer}“‘ Tmpact Ana\ysis} a3 JTPrewew] =0
Enter Irem 1D to searcl - Q. =z A
> Quicktinks (o ([ B B o00i0iphte & 000101/A Sunnary
[Z oonio1
B Home » = %% 000101jA;1-Plate ~ Properties - a2
Sty worklist » [ oootoaja
[ETIMy Projects » i 0o0101/4 Object: [oo010174 o
QMV Links » oo01L01/A =
[Amy saved searches % [ view Hame: (0010174 = !
» Dpen Items H
Description: [plate =
» History B
» Favorites S >
| 3 Named References o x|
[— L ™
@- Getting
Reference Hae | see | Remore [ type [ Lastvodfied [ volme |
f CMIRL [CATPart 000101 CATPart | 55 Kh| [tmanFile [31-10-2003 09:52  [volumel ]
15 My Tea —— -
open || ot | | Bt | X & & %
Struct
5 - o
T T=T T L
Ready X P mwg | O

Figure 34: “Table” item in My Teamcenter

Highlighting an ltem in CATIA

In cases where you have loaded an assembly structure to CATIA as described in the
steps above, it may be useful to find the corresponding model in the CATIA session of an

item displayed within the CMI RII application.

For this purpose, it is possible to highlight CATIA models in CATIA using the currently
selected item in the CMI RII application.

8) In the CMI RII application, select the item you want to be highlighted in the CATIA
— session and choose the Highlight in CATIA option in the Pop-Up menu.
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File Edt Tools Window Help

|sEaaz X TEAMCENTER
CMIRII =
Search S avirn i1 = o
[Enter Tem 15 to searcl - Hame | Item Id Revision OccurrenceMame |
—— E-7 % 000100/A;1-Table (view) 000100 A
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Figure 35: Highlight in CATIA in Pop-Up menu in CMI RIl application

CATIA comes to the foreground with the selected CATIA model highlighted.

[#]caTIA vS - [000100.CATPraduct] =] 4
El stat Fle  Edt  View Inset  Took  CMI  Analyze  Window  Help =1@1x|

L EE AT ABBALRT A4 5

AE BT DS

-

NP4 DBI R P BAY nBeésRAL 2
[ |

1 element selected

Figure 36: Highlighted item in CATIA V5
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CHAPTER 5

Working with CATIA V5

Introduction
This chapter describes the CMI interface between CATIA V5 and Teamcenter. Typical
tasks discussed are loading items/structures/drawings stored in Teamcenter into CATIA
V5 and creating/updating parts and drawings in Teamcenter. One of the main
subsections deals with creating and saving CATIA V4 models.

]

Product Structure CATIA V5 vs. Teamcenter

Product structures in Teamcenter correspond well to product structures found in CATIA
V5. The following graphic illustrates the product structure in Teamcenter and CATIA V5.
Bee e 08 g juet Joh OF fovm Sdw oo ﬂj

s LS EFSLBALF - L5875

TEAMCENTER

‘ ¥

SHCRPVBUEEE B ;

NERSyTEn B KO AR nTEERA L 2.
I = | &0}

xeme | r
R T e ]

E

Figure 37: Product Structure in Teamcenter and CATIA V5

]
CMI Toolbar

The following figure shows the toolbars of the CATIA V5 CMI module. Descriptions of the
toolbar and the command icons follow below.
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T

| Read from Teamcenter |

| Update Teamcenter |

| Synchronize Teamcenter |

A

| SaveAs in Teamcenter |

4

LLE BT LAEAERA LT 4

A

| Highlight in Teamcenter |

A T

| Check In/Outin TC

Restore Session
Save Session

| Use CATIA Catalog from Teamcenter |

| Create/Attach an Archive |

| Reconnect with Teamcenter |

| Modify non CATIA archive content |

| AddTemp from Teamcenter |

|Get original geometry from Teamcenter | | Insert from Teamcenter |

Figure 38: CMI Toolbar in CATIA V5

With the CMI toolbar it is possible to read files from the CMI RIl application in Teamcenter.
You can then modify the geometry in your CATIA V5 session. The modifications can be
updated in Teamcenter via the ‘Update Teamcenter’ or the ‘Synchronize Teamcenter’
button in CATIA V5.

The icon ‘Highlight in Teamcenter’ is only active if you are working with a product

You can get the Teamcenter information of the CATParts, CATProducts, CATDrawings,
and CATIA V4 Models with the CMI Info button if you loaded the product structure with
CMI to CATIA V5.

The other commands will be described in more detail later in this chapter.

CATDrawings in CMI RIl Application in Teamcenter

il

File Edt Tools Window Help

CATIA V5 will read all expanded assemblies, single CATDrawings from the Teamcenter
CMI RII application.

The following figure shows a CATDrawing in the CMI RII application:

TEAMCENTER

IEntErItEmID to searc| -

~ Quick Links Customize

B Hame »
Sy worklist »
|24 My Saved Searches »
Gy Links »

» Dpen Items
» History

} Favorites Organize

» IWant To.. Customize

@ Getting Started

& curn

My Teamcenter

Structure Manager

& = i 8 »

Ready

Name: Item Id Revision Occurrence hame

| BlE]

X% g EQ !

Figure 39: CMI RIl application with a CATDrawing dataset
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When you have transferred a CATDrawing from Teamcenter to CATIA V5 via the CMI RII
application, the drawing will be displayed in CATIA V5 in a new window.

CMI for CATIA V5 also supports CATIA V4 models and CATIA V5 Drawing files
(CATDrawings). CATDrawings may be included in assembly structures in Teamcenter,
however in CATIA V5 they will be displayed in separate windows as shown in the figure
below.

All normal CMI functions (Read, Update, Create, and Save As) may be used with
CATDrawings and CATParts within CATIA V5.

[%]cATIA ¥vs - [CMI - 000100] =10 x|
ﬂstt Fle Edt View Insert Tools CMI  Window  Help _18 x|

PETVELEE V-0 8- P T i s

ShEEt 1 |

Hayg @l e gl

s

Ll

&

71 O

m0!

,_

|

|

|

|

|

|
259
Lok

|

i o[ :
N BHaynRe @R Ao Baes BeqanE /e 2,
1 element selected [ ol =

Figure 40: Drawing Workbench for Read, Update,
Create or Save As CATDrawing

CMIltoolbar: Read From Workbench

£

With the ‘Read from Workbench’ button in the CMI Toolbar the content of the CMI RII
application in Teamcenter may be read into CATIA V5. The CMI RII application may
contain CATDrawings, and assembly structures.

If you want to send one or more assemblies, CATParts or CATDrawings to CATIA V5
follow these instructions:

F-) Drag and drop, Send drawings (CMI2DGeo datasets) or assemblies (items) into CMI
- RII.

Expand or Deexpand the assemblies in the CMI RII application. Only those items
that are shown in the CMI RII application will be opened in CATIA.

Read Teamcenter CATIA items with the Read From Workbench icon ';é .

Every top-level item in the CMI RII application will be opened in a separate browser
in CATIA V5.

A “If the Structure Manager application is the current active application in the
: Teamcenter Rich Client the Structure Manager content will be read to CATIA mstead
- of the content of the CMI RII application.
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CMitoolbar: Update Teamcenter

B

This command updates geometry and position information in Teamcenter.

Modify the content in CATIA.

Write the modifications back with Update Teamcenter icon
All files in the assembly and the position information (transformation matrix) which
have been modified in CATIA will be updated in Teamcenter.

ﬁ.

&

The success (green icon) and more detailed information (Figure 41) are then displayed to
the user.

M1 YWarnings |

ITkemRevision Tkem 000100)4; 1-Table updated. a
CMIStructure Dataset 000100/A created.

CMIStructure Dataset 000100/4 attached to Ihem 000100/4;1-Table,
CMIStructure object 00010084 checked out.

File 000100, CATProduct For Dataset 00010074 uploaded, LI

—CMI Operation Stakus

o Update finished

Clase I

Figure 41: Dialog Window for Update Teamcenter

CMiltoolbar: Synchronization in Teamcenter

8

This command updates Teamcenter with any changes made to your CATIA V5 product
structure. The changes that will be reflected in Teamcenter include:

= any geometry and position information changes,

= the creation of any new CATParts/cgrs/models and CATProducts that have been
added to your product structure,

= the creation of any new CATPart/cgr/model and CATProduct instances,

= the removal of CATProducts and CATPart/cgr/model instances from the product
structure.

The changes made to the product structure since the last Read/Update/Synchronize are
presented in the form of a list of operations to be performed in Teamcenter.

: Modify your product structure in CATIA by adding a new CATPart/cgr, adding a new
‘?' CATProduct, removing a product or by changing the geometry of a CATPart.
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Write the modifications back to Teamcenter with the Synchronization in Teamcenter

icon ﬁ .

The following dialog will appear, showing which changes need to be written to

Teamcenter:
C =lalx
Bl gttt Fle  Edit  View Insert  Tooks  CMI  Anslyze  Window  Help =181 x|
LB AL AEBALBT L6 5

@l gl

!

o) ) &5 69 & |

Ix

(CMI Synchronize Teamcenter

COperation List
G e
0104 ase ;
00103 TableDecoration CATPraduct Create Link ... ¥
000100 Table CATProduct Update / Lirk ... ¥

Ediit POM-Part catenory... | L | synchronizs | close | J

utput window

[ Sinale step mods
—

Figure 42: The Synchronize Teamcenter dialog

The dialog's Operation column shows which procedures need to be performed in
Teamcenter for each object and may be a combination of the following:

Update The file and positional changes of any children will be updated in
Teamcenter.
Create The object will be created in Teamcenter. The object is completely

new and not already in Teamcenter.

Link Child At least one new parent-child relation will be created in Teamcenter.
This reflects the addition of a child product in CATIA.

Drop Child At least one parent-child relation will be deleted in Teamcenter. This
reflects the deletion of a child product of the object in CATIA.

The column Execute shows whether the operation will be executed or not. If there is any
reason why the operation cannot be executed, then the reasons will be shown in the
Result column.

_ If new geometry files are to be created in Teamcenter the default is BOM Type. This
‘? will become an item and a dataset in Teamcenter.

With the Edit PDM-Part category button the category can be changed to No BOM
Type in the Edit new PDM-Part category dialog (see Figure 43). This file will become
a dataset in Teamcenter and will be attached to the parent item.
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Edit new PDM-Part categor: e

PartMumber |Dgg1nq

POM-Part category |NEE=roe Type

[ apply to all news POM-Parts

< Preyious | [iexh = | Ok |

Figure 43: Edit new PDM-Part category dialog

If the Synchronize button is pressed, the list of executable operations is worked
through in the order shown on the screen.

The results from Teamcenter are shown in the Output Window below the list.

The Update operation:

CATIA File objects will be updated in Teamcenter. No user interaction is necessary.
The Create operation:

CATIA File objects will be created in Teamcenter and the following steps will be
completed:

- A Teamcenter item will be created.
The created item is also linked to the user’s Newstuff Folder.

- A dataset will be created under the item.

- The file will be imported in the dataset as Named Reference with the correct
type (CMI3DGeo or CMIStructure).

The Link Child operation:

- This may only appear as an operation for CATProduct objects, as CATParts
cannot contain sub-products. In Teamcenter any new children will be added
to the Teamcenter item of the parent object by creating a new BOM Line.

The Drop Child operation:

- This may only appear as an operation for CATProduct objects as CATParts
cannot contain sub-products. In Teamcenter any child CATProducts deleted
from the CATIA product structure will be detached from the Teamcenter item
of the parent object by removing the BOM Line.

After every operation the success or failure will be registered in the result column of
the dialog. If an operation fails the output window will provide you with the cause of
the failure.
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[+]caT1a v5 - [000100.CATProduct] (=] 3}

] tart  File  Edit  View Insert  Tools CMI  Analyze  Window  Help . [

 LAE AL AEBELIT HLM G

CMI Synchronize Teamcenter

peration List
Next Op | Part Number Momenclature Categor Operation Execute | Result
000104 Vase CATPart (BOM)  Create v
000103 TableDecoration CATProduct Create fLink... ¥ Succeeded
000100 Table CATPraduct Update f Link ... ¥ Succeeded

Eclt FOM Part category... | el | sncloze. | Lebse ] ||

Output window

< 000104 CATPart (BOM): Create = f’
Item Item DO0104)4; 1-Vase created,
(CMI3DGeo Dataset O00104/A created.
{CMI3DGeo object 000104/4 checked out. _I

File 000104, CATPart for Dataset 000104/ uploaded,

Eslng\e step mode
Figure 44: The Synchronization in Teamcenter dialog with success

CMItoolbar: SaveAs in Teamcenter

@

With this command a CATPart or CATDrawing currently set active in CATIA V5 can
replace another file in Teamcenter. A CATPart or CATDrawing selected in Teamcenter
and then dropped into CMI RII will be overwritten by the contents of the CATPart or
CATDrawing in CATIA memory.

Design or load your CATPart or CATDrawing in a separate window in CATIA.

In CATIA V5 select the Save As in Teamcenter icon -dﬁ .

Drag and drop or Send an item into the CMI RIl application in Teamcenter.

&

In order to Save As in Teamcenter with a CATDrawing, drag the ‘new’ CATDrawing
dataset to be overwritten into the CMI RII application in Teamcenter. The
CATDrawing active in CATIA V5 will then overwrite its content.

In order to Save As in Teamcenter with a CATPart, drag the ‘new’ item to be
overwritten into the CMIRII application in Teamcenter. The CATPart active in CATIA
V5 will then overwrite its content.

'~ Please take care when you ‘Save As’ a CATPart which is used in a CATProduct - a -
Q{ - reference to the CATPart is stored within the parent CATProduct. Make sure that the:
‘new CATPart is compatible. [

CMitoolbar: Highlight in Workbench

b4
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€

If you want to highlight CATParts, CATProducts, and CATIA V4 models in the CMI RII
application triggered by CATIA V5 perform the following steps.

In CATIA V5 select the CATIA objects you want to highlight in the CMI RII

application and choose the Highlight in Workbench icon ég from the CATIA CMI
toolbar.

Now the items are selected in the CMI RIl application.

I
CMiltoolbar: Get original geometry from Teamcenter

r

==

The Get original geometry from Teamcenter command retrieves geometry files (CATPart
or CATIA V4 model) from Teamcenter if the geometry files are not yet loaded in CATIA
V5.

A CATProduct, CATPart or CATIA V4 Model has to be selected in the product
structure.

: The function is used in context of huge product structures in CATIA to get the
: original geometry file from Teamcenter if the Do not activate default shapes on open
- option is set in the CATIA Product Visualization settings (see Figure 45).

ostions 2=

A “F Options

Product Structure | Product Visualization | Recondiiation | Tree Customization >

| 7 B General

W] Display

M Compatibiliy

Representation

< Do ot activate default shapes on open

visualization mode type

%Parameters T Me e W@ Visualization mode with local cache

(1 Mulki process visualization mode with local cache

7% Devices and virtual Realty
O Mare

{ n—-Infrastructure

= 1raterial Ubrary

= [ Catalog Editor

IR Photo studio

- P Real Time Rendering
|- €5 Part Infrastructure
1" DELMIA Infrastructure

I~ 3D Annokatians Infrastructun

ﬁCoHahurat\on Infrastructurs
Mechanical Design

Shape

Analysis & Simulation

ﬁ AEC Plant
pal &l

@ ok | Scancel]

Figure 45: Do not activate default shapes on open option in CATIA V5

CMitoolbar: Add Temp

B

32

CMI RII User Manual



The AddTemp command allows the user to visualize a temporary structure together with
the working one.

For example, if the user is making a design of a car and wants to see if the luggage boot
is big enough, he can load a suitcase as a temporary structure by doing the following
(supposing that the car structure is already loaded):

In CATIA V5, go to Tools 2Options 2>Compatibility (Tab: “CMI”) and make sure that
the option “Use one temporary product window...” is checked.

Read an assembly (here the car assembly) into CATIA using the Read command in
CMl toolbar.

4§+

In CATIA V5 select the AddTemp from Teamcenter icon % .

Drop the assembly or model you want to add temporarily to CATIA (the suitcase)
into the CMI RII application. Expand it as necessary. Click Tools 2Temp To CATIA

in the menu or press the Temp to CATIA icon 3 in the CMI RII toolbar. Changes or
expands you make to other assembly structures in the CMI RIl application will not be
sent to CATIA.

: CATIA comes to the foreground with both the original and temporarily added
‘?' structures loaded in the same window — here the car and the suitcase structure.

&

It will not be possible to make any changes to the temporarily added (suitcase)
structure.

The temporarily added part/structure is removed from the CMI RII application after
you sent it to CATIA.

ffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffffff

A - All Part Numbers and File Names in the temporarily added structure are prefixed
;Wlth “TMP#_", where “#” is a counter in CATIA V5, beginning with 1. Every AddTemp
“will increase the counter. This prefix is customizable by the customer.

!~ !Limitation:
: CATProducts are not transferred to CATIA, the products will be represented by
:“CATIA Components”. Only position information from Teamcenter is processed.

Visualize multiple revisions of an Assembly using Add Temp

Add Temp in CATIA V5 can be used to load different versions (revisions) of an assembly
or model at the same time. In order to make this possible, the Part Numbers and File
Names of the temporarily added assembly are prefixed with “TMP# _".

In CATIA V5, go to Tools 2Options 2>Compatibility (Tab: “CMI”) and make sure that
the option “Use one temporary product window...” is checked.

o

Read revision B of your assembly as described in CMI toolbar: Read From
Workbench.

&

You will find that it is opened in CATIA underneath a product tagged “CMI
Workbench”.

Find and expand Revision A of your assembly (drop it in the CMI RIl application
window and use the Expand Below command in Teamcenter). Click Tools 2Temp

To CATIA in the menu or press the Temp to CATIA icon & in the CMI RII toolbar.
Changes or expands you make to other assembly structures in the Workbench will
not be sent to CATIA.

o

In CATIA V5 select the Add Temp from Teamcenter icon

&
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: Revision A and B of your assembly are opened in the same Window in CATIA V5.
“?' You can overlay and position the assemblies relative to each other for comparison.

CMIltoolbar: Insert from Teamcenter

=

The Insert from Teamcenter command allows the user to load a CMI structure under a
selected product.

Read an assembly into CATIA V5 using the Read from Workbench command in CMI
i toolbar.

Select a product to be the root of the inserted structure.

In CATIA V5 select the Insert from Teamcenter icon 'l-—i

Drop the assembly structure you want to use in CATIA V5 in the CMI RII application
window. Expand it as necessary. Click Tools 2Insert To CATIA in the menu or press
the Insert To CATIA icon == in the CMI RII toolbar. Changes or expands you make
to other assembly structures in the Workbench will not be sent to CATIA.

CATIA comes to the foreground with the selected product and the used structure.

The dropped part/structure is removed from the CMI RIl application window after you
sent it to CATIA.

Via Synchronize you can save the new Use-Relation in Teamcenter.

N

€

CMiltoolbar: Local Save and Restore

% % Using Save Local the content of the CATIA V5 session can be stored locally.

This snapshot of the session will persist even when CATIA V5 is closed.

% % When the session is restored with Restore Local, you can continue your work
as if you had just used Read from Teamcenter, i.e. you can perform Updates.

The Restore Local command is only available when the CATIA is empty —i.e. no
documents are open — to avoid conflicts.

- With Save/Restore Local you can avoid reading large assemblies from Teamcenter :
‘repeatedly. However, the status of the data in Teamcenter may change if you keep
-your local snapshot for a long time. It may get “stale”.

!

™

/-
»

The following restrictions apply:
= Only one saved session is maintained at a time.

= The session can only be saved when the data is up to date. l.e. there are no files in a
modified state, and no new files.
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= The save/restore local does not restore files that were not loaded from the PDM
system.

CMItoolbar: Reconnect with Teamcenter

&

CMI recognizes files that have been loaded into CATIA V5 through the CMI RII application
window. Since it knows that they are from Teamcenter, it can update them there.

Other files, which you load with e g. File 2Open, it will not know. They will be regarded by
Synchronize as new files, and it will create new Teamcenter objects for them.

If you open a product structure from disk that contains files that are already in
Teamcenter, you can use Reconnect with Teamcenter to make CMI RIl recognize these
files. It will recognize products if the part number is correct, and CATPart/model files
based upon their filename. If the CATPart is a BOM CATPart (Component) in Teamcenter,
the part number must also match.

CMIReconnectDialog 2lx
Status | TC file access | Fartnumber | Inskancename | Parent Parknumber | Type | Filename |A
¥ CMI-Unknown  Read Write® Engine_Assm Engine_fssm CATProduct Engine_Assm. CATProduct
¥ CMI-Unknown  Read Write® FixedParts_fissm FixedParts_Assm.1 Engine_Assmm CATProduct FixedParts_Assm, CATProduck
'.,[" CMI-Unknown  Read Write® CylinderBlock CylinderBlock, 1 FixedParts_assm CATProduct CylinderBlock, CATProduct o
¥ cMI-Unknown  Read write® Zylinderblock, 2 CylinderBlock CATPart 01_Zylinderblock, CATPart
¥ CMI-Unknown  Read Write® Rack_Assm Foack_pssm. 1 FixedParks_assm CATProduct Rack_fssm, CATProduct
wF CMI-Refere... Read Write Rack Assembly Rack.1 Rack_fssmm CATProduct Rack. CATPraduct
v CMI-Instance  Riead Write Chassis 3dmap Chassis, 1 Rack Assembly 3dmap Chassis, 3dmap
w CMI-Instance  Read Write Chassis CATShape Chassis,2 Rack Assembly CATShape Chassis, CATShape
¥ cMI-Unknown  Read write® Screw Screw. 1 Rack_fssm CATProduct Screw, CATProduct
¥ cMI-Unknown  Read Write® Schraube. 1 Screw CATPart 10_5chraube. CATPart LI
Select unknown_l Reconneck selectedJ

| W& Cancel

Figure 46: Reconnect dialog

There are three possible states:

CMI-Unknown CMI does not know this item at all. It would be created as a new
part in Teamcenter.

CMI-Reference | CMI knows this item is in Teamcenter. But it appears that in
Teamcenter there is no instance known by the same instance name
under the same parent item. Maybe it was deleted or is new. It
would be created as a new part instance in Teamcenter.

CMl-Instance CMI knows this instance is in Teamcenter. It can be updated in
Teamcenter.

An asterisk (*) signifies that the Reconnect Dialog recognized the item, but it is not yet
reconnected. Items are actually reconnected when you close the dialog with OK. Click
Cancel to keep them as unknown, e.g. if you want to save them as new Teamcenter
objects.

Load a CATProduct into CATIA V5 using File >Open.

In CATIA V5 select the Reconnect with Teamcenter icon ‘@' .
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In the CMI Reconnect Dialog, click Select unknown. In this case, all lines will be
selected. Click Reconnect selected. If any items are recognized in Teamcenter, they
will change their status. To reconnect these items, close the dialog with OK. Click
Cancel to leave the dialog without reconnecting the items.

Reconnected items that are writeable in Teamcenter will be in the “modified” state,
to be able to update them in Teamcenter.

Use Synchronize to create the unknown/new data and to update the reconnected
files.

 If you want to keep individual items as new, unselect them before you click
“Reconnect selected.

CMitoolbar: CMI Manage Catalogs

£

This command is described in section Manage Catalogs on page 41.

CMiItoolbar: CMI Info

A

This command displays the information from Teamcenter for CATParts, CGRs,
CATProducts, CATDrawings and CATIA V4 Models.

The More ... button displays attributes of the correspondent Teamcenter objects. The
range of attributes can be customized.

mmnn ¥5 - [000100.CATProduct] . =[0I |

] st Fle  Edit  View Insert  Took  CMI fnslyze  Window  Help ==l x|

| < ET
L8 afasEs

[Product Properties

S | Multipl Objects |

- Catis sttribtes
Exchange map Fie name:
lcﬁ?ms.mpmm
[ Changed in Catia

[~ Teamcenter attributes

O rart read only

[ File read ary

[ File attarhatle

Partrumber:  [300103
Instancename: (0001031
Revision: A
Momenclaturs: [TableDecaration

Mare attribute information

rMore |

=
i
n
attribute Name [ attribute value [+] M) év
Current 1D 000103 —
Current Hame TableDecoration J | p—
Current Revision A + s
Date Created 31-30-2009 10:16 SwHe B G L Catia
ExCO - Explore Checked Out € TG
Group ID Enginesring Al&l
5] 000103
Is Modifiable ¥
Item 000103-TableDeroration
TtemRevision Master 00010348 =l
dose_|

Figure 47: Information dialog window for CATProduct with “More Attributes”
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Select the CATPart, CATProduct, CATDrawing or CATIA V4 Model.

In CATIA V5 select the CMI Info icon ﬁ . The appropriate dialog info window

appears.
A You can also select multiple CATIA items. Information will be displayed in a table
Q “view.
[S]chTia vs [onotoocateroduct) iglx]
Edi i nser ;lilll
2lx|
Sl et || gl Objects |
State | Access [cmr [ Parthiomber [ Momendlature |
Open Read Write  CMD 000100 Table
Open Read Wrike  CMI noo102 Leg
Open Read Write ML noo102 Leg
Open Read Write  CMI 000102 Leg
Open Read Wrike  CMI noo102 Leg
Open Read Write  CML 000101 Plate
Open Read Whrike  CMI 000103 TableDecaration
Open Read Write ML noo104 Wase
NBEIL B0 Hre B4 9343aA5 2.
8 elemerts selected [ = | | i |
Figure 48: CMI Information for multiple items
]
Handling of CATDrawings

CATDrawings can be included in your assembly structures in Teamcenter. All the usual
functions (Read, Update, Create and Save As) are supported for CATDrawings in CATIA
V5 via the CMI toolbar.

CATDrawings may be created for single models or for assemblies. There are however
several caveats when working with CATDrawings and CMI, depending on the context of
the CATDrawing.

Creating a CATDrawing from a Single Model

When creating a CATDrawing for a CATPart, send the CATPart item from Teamcenter to
CATIA V5, and then create the CATDrawing. This method will preserve the context of the
CATDrawing - irrespective of whether the CATPart is later loaded into CATIA singly or as
part of an assembly. If you later make changes to the CATPart, and you wish the
CATDrawing to update and reflect the changes, you must load both the CATPart and the
CATDrawing in CATIA V5 using CMI before you update the CATDrawing.

8) Drag and drop the CATPart item on the CMI RII application or use SendTo>CMI RII
%o  with the CATPart Item.

Select Tools 2Send To CATIA or use the Send To CATIA icon &7 in the CMI RII
toolbar.
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Create the CATDrawing with the usual CATIA V5 functions.

Select the Synchronize in Teamcenter icon ﬁ

Creating a CATDrawing from a Product Structure

8) Drag and drop the assembly into the CMI RII application.
4

Select Tools 2Send To CATIA or use the Send To CATIA icon &1 in the CMI RII

toolbar.

Create the CATDrawing with the usual CATIA V5 functions.

Select the Synchronize in Teamcenter icon ﬁ

Automatic Update of CATDrawing title block parameter

M CMI RII can automatically update text fields in the Drawing title blocks with attributes
Q from Teamcenter. This requires a configuration in Teamcenter.

E) Use Edit>Options to open the Teamcenter preferences dialog.
4

Switch to the index tab and check the following Preferences:
- CM12DGeoParameterAttributesTC
- CMI2DGeoParameterAttributesCATIA

(see Figure 49).

52 Options

{Search On Preference Mame
[
|

|
W [Preference Detaik

r~Cakeqgar

CMIZD ‘-’\ ;l {Name

~Preferences List

) | ==

|CMIZDGanParamaternttrlhutescmln

CMIZDGeoParameterAttributesTC

| i~ Description

~Current Yalue:

object_desc
object_name

|
0EE0D |

Z preferences found.

B

I'I|:tinn-'. | Index | Search | Organization

Details | Mew | Category

) Ko

Import | Export

Cancel

Figure 49: Options Dialog in Teamcenter

E) CMI2DGeoParameterAttributesTC defines a list of Teamcenter attribute names
4 of the dataset object in Teamcenter.

Example:
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object desc
object_name

CMI12DGeoParameterAttributesCATIA defines the parameter names in CATIA.

Example:

PdmDescription
PdmNumber

These two lists must have the same length.

In CATIA the Knowledgeware Parameters can be defined in the CATDrawing object.

With the Attribute Link command in CATIA these parameters can be connected to
text fields in the CATDrawing.

CMI RII will update the Knowledgeware Parameters in the CATDrawing document.

With the example values above the object_desc attribute of the CMI2DGeo dataset is
read in Teamcenter and set in the PdmDescription parameter in CATIA (see Figure 50)
and the object_name attribute of the CMI2DGeo dataset is read in Teamcenter and set
in the PdmDescription parameter in CATIA.

Tools  CMI  Window  Help

Miew  Insert
2 000282 seet.1 | =
5 1
=—giml Parameters
15 PdmDescription 1
TE' [CESTOAED BY: = 1 6:)
[=] PdmName .., Designer1? o -
- o B 1000282 - Desc E .
Edit Parameter 3
8] T a}]ﬂv
| PdmDescription - Desg T 'Systems D i ;@
T | i |.L o -
; | — 000282/A 1/1 18 - el
Bottom view [T eronirg 14 our prweriy; iF raa™F be repratueed or cmmmicated ithwE sur written spreseeet: Al . 08
Left view c B A 3
2l
LA I
ometric view| Elv_
B
d | »r‘ oo
- ] = 7.
NEESYBaY @ e B BIeaaBEE '@ @ 2Z,
Edit parameter | . | E

Figure 50: CATDrawing Parameter in CATIA V5

With the CMIRead command the parameters are updated in the CATDrawing document in
CATIA.
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I
Handling of cgr and model files

CATIA V5 cgr files and CATIA V4 Model files are managed as representation of an
embedded component in the product structure. It is not possible to modify such a
representation directly. It is only possible to use the Save As function of CATIA V5 to
create a new cgr or model file of a loaded CATPart or CATProduct. To update the
representation you have to replace the original representation by the new representation.

- Load an assembly which uses a cgr or model in the product structure. And use the
; right click Representations 2?Manage Representations ... command (Figure 51).

=I0i
e

El oot Ele Edt  Wew Insert Tooks M Anabee  Window  Help
LB ESSEABS LR 4

y [Tab

k=3

Manage Representations 2 x|

Mame SOUrce Type | Default | Activated
669 olCMIEMAPIO04660. model  model  ves ves

Assodiate...
Remove
Replace...
REname. ..

4 0|
Ackivate ! Deactivate I Set fs Default I Close I

NEE8 290 X P’ B85

Select representations [ ol | = |

Figure 51: Manage Representation dialog of CATIA V5

Use the “Replace” function to use the cgr or model file with a new representation.
L]

Manage Representations ﬂll

Associate. . I
Remove I
Reelace. . I
Rename. .. I

Activate I Deactivate I Set fs Defaulk I Close I

Figure 52: Manage Representation dialog of CATIA V5 with new model file

- Use the CMI Update or Synchronize functionality to update the new cgr or model file
; in Teamcenter.

M- During the CMI Update/Synchronize process CMI replaces the original
Q : representation file in the exchange directory by the new representation file and
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“new representation file (which has the name of the old file) is updated in
: Teamcenter.

éTo use this function you need write access to the cgr or model data item in
: Teamcenter. Although the cgr or model is represented in an embedded component
of a higher CATProduct you need no write access to the CATProduct.

‘!.  CRestrictons: e
: - There must be only one representation in one component.
.- The “Name” of the representation must not change.

Catalog Management

CMI can also manage catalog files in Teamcenter. Teamcenter compatible catalogs
reference files and items that are actually stored in Teamcenter. If the user opens or
inserts a file from the catalog, CMI retrieves the corresponding data from Teamcenter and
starts the defined catalog function (see section Update or Create Catalog for function
details) with the retrieved file(s).

Manage Catalogs
'~ The Manage Catalogs icon is enabled when you have a CATProduct active. It allows:
14 ‘retrieving catalogs from Teamcenter for browsing. [

: After starting the Manage Catalogs command the Select Catalog dialog will be
‘?' opened in CATIA.

Select Catalog for browsing ﬂil

CatalogDocument1
infodba_catalogl
jzeng_catalo

sde5225_Catalog

Refresh List From Teamcenter ] Cpen Catalog For Browsing J

Figure 53: Select catalog for browsing dialog

: Pick from the list of catalogs available in Teamcenter and select the Open Catalog
‘?' for Browsing button. The catalog will be opened in a CATIA Catalog browser.
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Catalog Browser:c:, CMIXMAP Bolts.catalog _"Ill

Current; Type 1 j EI

4| »
Filter:l ﬁ | Table > I Launch I
-
1 004457
2 004455
3 004453 ik
4 004451
5 On44dn x|
@ Ok & Cancel

Figure 54: Bolt Catalog opened in CATIA

: Double click an end chapter to open the item from Teamcenter. CMI RIl will load the
‘? required files from Teamcenter if needed.

L
~ Q You cannot use Open Document or Open As New Document in this context.
Read Catalog
M!'-»  The administrator needs to set CMI_ENABLE_CMICATALOGREADCMD=ON in the
V “CATIA environment in order to enable the Read Catalog function.

gThe Read Catalog icon is enabled when you have a CATProduct active. It allows
:you to retrieve catalogs from Teamcenter for editing.

_ After starting the Read Catalog command the Select Catalog dialog will be opened
‘? in CATIA. Read Catalog allows to retrieve CATCatalogs from Teamcenter for editing.

Select Catalog for editing 21x|

CatalogDocument1
izeng_ratalo

£de5225_Catalog

Refresh List from Teamcenter I Open Catalog for Editing I
Close I
—

Figure 55: Select Catalog for editing dialog

: Pick from the list of catalogs available in Teamcenter and select the Open Catalog
‘? for Editing button. The catalog document will be opened in a CATIA catalog editor.
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(0] x|

jﬁ|.{7|

004457 Document e APYO04457, CATPark
. : CATPart
Description Defi ] 3 CnTPart
CATPark
Mame: | 004457 o TRart
Reference | Kevword values | Preview
Type: Document
File name: | c:WCMIXMAPYO04457, CATPark
Select
Select document I
Select Preview
Select external Feature
= = [L5unich
Select dacument in sessian
@ oK I w Cancel l
' [ -

Figure 56: Edit catalog in CATIA

_ Use the Select document in session button to build the catalog from parts or files
‘? that were opened from Teamcenter via CMI.

Update or Create Catalog

DA “ The administrator needs to set CM1_ENABLE_CMICATALOGUPDCRECMD=ON in the
¥ - CATIA environment in order to enable the Update or Create Catalog function. The
- Update or Create Catalog icon is enabled when you have a catalog active.

: Update or Create Catalog allows saving new or updated catalogs in Teamcenter. It
‘? will manage the necessary keyword attributes so that the items contained in the
catalog can be retrieved from the Teamcenter database instead of the local file

system.

: After starting the Update or Create Catalog command the catalog document is
‘? analyzed and the following dialog is shown.
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CMI - Synchronize Catalog 2|
Catalog Filenarne: Catalog Marne:
| ExarpleCatalog.catalog | ExampleCatalog. catalog
ame | Tvpe | Skatus
20080208 Modell Cpen Updated by CMI
20080207 _Modell Cpen as copy Loaded by CMI
20080225_Model1 Cpen Mot known by CMI
LDF_A Instantiate Created by CMI
Edit: selected . I anchronize I
Close: I
-

Figure 57: Synchronize Catalog dialog

For new catalogs that were not already opened from Teamcenter, the user can
change the file name which should be used in Teamcenter.

¥

- - The type can be Open, Open as copy, and Instantiate. These types describe the
way in which the items will be handled when the catalog is used with the Manage
: Catalogs command.

!
™
/-

Open Open the referenced object in CATIA so that the
existing Teamcenter item is used (e.g. standard part).

Open as copy Open the referenced object in CATIA so that it will be
recognized as a new item in Teamcenter (e.g.
templates).

Instantiate Instantiate is used for Features and Power copies which

will be instantiated in the active document.

éThe Status Field can be Loaded by CMI, Updated by CMI, Not known by CMI,
‘and Created by CMI.

Loaded by CMI The item is from Teamcenter and already was in the
catalog at load time.

Updated by CMI The item is from Teamcenter but the type was changed.

Not Known by CMI | The item is not from Teamcenter.

Created by CMI The referenced file was opened from Teamcenter and
is new in the catalog.

: After pressing the Synchronize icon CMI will check all entries and if there are
‘?' unknown entries, the user must confirm, that he will continue.
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CMI |

i At least one catalog endchapter is not compatible with CMI
Do you wank o continue with the Sync operation?

Figure 58: Confirmation dialog for unknown entries in the synchronize catalog
command

A EThis indicates that there is an item referenced in the catalog that is not managed by :
Q : Teamcenter. 1

8) Next the catalog is registered or updated in Teamcenter.
- Figure 59 is shown when the Synchronize command ends successfully.

CMI - Synchronize Catalog e
Catalog Filenarme: atalog Marme:
ExampleCatalog. catalog |ExampleCatang.cata|0g
Mame: | Twpe | Status
20080206 _Madell Cpen Updated by CMI
20080207 _Madell Open as copy Loadad by CMI
20080225 _Maodell Cpen Mok known by CMI
UDF_A Instantiate Created by CMI

Edit selected .., i Synchronize i

Operation succeeded in Teamcenter, o

Close

Figure 59: Synchronize Catalog with success
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|
Handling of CMI Archives

CMI supports the use of CMI Archives. A CMI Archive is a dataset in Teamcenter which
contains a CATIA V5 structure. The structure has one root item which can be a
CATProduct or a CATPart. If the root item is a CATProduct, it can contain more items of
type CATIA V5 Component, CATIA V5 CATProduct or CATIA V5 CATPart.

In the following sections the handling of CMI Archives is described in detail.

E) First open the CMI RII application in Teamcenter and open an Item in the CMI RII
> application (see Figure 60). After sending the CMI RII application content to CATIA
V5 (Tools 2Send To CATIA in Teamcenter or the Read Command in CATIA V5), the

product structure is loaded in the CATIA V5 application.

EPCMIRII - Teamcenter 8 o [m] B35
File Edit Tooks Wwindow Help

[aEaRe R |H» TEAMCENTER

Search A7 cHIRI 52
[Enter tem 10 to sea - Hame | ttemid [ mevison | occumenceMame |
- Quicktinks  (opomon 7 % 000150/4;1  DOD1ED A

& Home >

KMy Worklist »

[2 My saved Searches

Sty Links »

* Open [tems

% 000160741

» History

» Favorites Oraanize
’f CMI RII

:iﬁj My Teamcenter

Structure Manager

& 2 E g > | al|

Ready X% WO = S0

Figure 60: Item 000160 in the CMI RIl application window

R1=IEY
BEE

EJ ctat  Fle  Edit  View Insert Tools CMI  Analyze  Window  Help

| L8RS LEAERALT - £L5 4

@l gl

_BECBEEBE

Ngaimraoc @ e Baed ln 2,
Select an object or a command [ o | |

Figure 61: Loaded item 000160 in CATIA V5
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Figure 61 shows the loaded product in CATIA V5. Now we add the structure which should
be attached as CMI Archive as child items to the item 000160. In our example the three
possible types are added under the root item (see Figure 62).

[$]CATIA ¥5 - [CMI - D00160]

EJ ctat  File  Edt wiew Insert  Tools  CMI  Analyze  Window  Help

L EBAF LESABE LTS H8

as
i b

00160

1 element selected

NEEs YRR ke rBaeE n 2,
|

Figure 62: CMI Archive root product with three children

Select the root product which should be attached as CMI Archive (see “ArchiveRoot
i (ArchiveRoot.1)" in Figure 62). The parent object of the selected item must be
loaded from CMI. The CMI Archive will be attached to an existing CMI structure by
using the Attach Archive CMI toolbar button.

In CATIA V5 select the Attach Archive icon. -4

In the Teamcenter client the create dialog for the new dataset (see Figure 63) will

&

appear.
I create CMI Archive Dataset x|
Basic Information
Mame
o064 #
CMI Archive Dataset Information
Description
e
-
4 I I 3
Ok | Cancel |

Figure 63: Create CMI Archive Dataset dialog

After creating all objects and relations in Teamcenter the user will be asked to
update the parent product in Teamcenter (see Figure 64).

&

CMIRII |
.
\1 ) Archive attached successfully, do you want to update the parent product now?
o |

Figure 64: Update parent product message box
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E) After the update the user gets the information from Teamcenter in a message
= window within CATIA V5 (see Figure 65).

CMIArchive Dataset 000160, 1/A created.
File D00160.1.CMIArchive For Dataset 000160.1/4 uploaded.
CMIArchive Dataset 000160, 1/A attached to Them 000160/4;1,

CMI Warnings | M Infarm:

Update finished
Additional messages fram CMI Update command

CMIStructure Dataset 000160/4 updated.
File 000160.CATProduct For Dataset 000160)4 uploaded.

CMIArchive Dataset 000160, 1A updated.
File D00180.1.CMIArchive For Dataset 000160.1/A uploaded.

"CMI Cperation Skatus

o Attach archive successful

Close l

Figure 65: CMI Messages window

8) CMI RII has created a new CMI Archive dataset in Teamcenter. The dataset is
— linked with the item 000160. Figure 66 shows the expanded CMI Archive dataset in
the My Teamcenter application.

EPMy Teamcenter (2007) - Teamcenter 8 =10 x|

File Edt View Translation CMI-RII Tools ‘Window Help
IR E@lx [RS8 Qo= TEAMCENTER

My Teamcenter (2007) ( Alexander Staudinger (ast2) - Engneering/Designer [IMC-516457144] )

Search 0 My Teamcenter (20073 £3 =40
Enter Ttem ID to se: - %, 000160 E
- QuickLinks - oo =) Folders 3 JDDG]BD.I;’A * Summary v
———— ; -
£BHome » L3 00010300160 Obiect: [oooie0 1/
%My ‘worklist > Y
% 000160/4;1 Marne:
[ETry Projects > ’ PODLED. 174
G 1y Links »
LMy Saved Searches
L8y Saved searches £ Descripkion:
~ Open Items % 000160781

|27 nootenja

; CMI RII S loo0160.1/4
-] 000160/4

ii1; My Teamcenter -5 View

Structure Manager &5 Chack Out and Edit |

eBe o> ||Bse
Ready 7 X% FaBRg EI;D

Summary Impact Analysis

Figure 66: CMI Archive item in Teamcenter

\.*_ In CATIA V5 the Teamcenter data is attached for the CMI Archive. The CMI info
; dialog (see Figure 67) shows the information for the CMI Archive object in CATIA
V5.
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Sleamiavs o ooosen] -loix]

EJ stat Bl Edt view Insert  Iools  CMI fnalyze  window  Help =& =]

| £ .66 5 2 T — 20
= Jarch i

Multiple Objects |

r—(Catia attributes

Exchange map file name:
IC:\CMIJMRPIUUDI&U. 1.CMIArchive:
[ changed in Catia
—Teamcenter attributes

=R E i Sl

[ Part read only

Partnumber; [
Instancename: | njg

Rewision;
Momenclature: [rja

More attribute information
rMore ] |

BOCRREEE !

-
NP BED % e B

1 element selected |

Figure 67: CMI Archive Information

- The CMI Archive can be modified or extended, e.g. by adding new CATParts,
\ CATProducts, etc. A changed CMI Archive can be updated in Teamcenter with the
standard CMI Update commands.

It is possible to add some non CATIA files to the CMI Archive. By default these files have
to be located in the CMI exchange directory.

files. Therefore use the CATIA - Tools - Options functionality.

In General->Compatibility>CMI please select “Use extra directory for non CATIA
items in CMI-Archive” and set a directory.

Note: you have to restart CATIA after changing this setting.

It is possible to select a special directory from where you can select non CATIA

To manage non CATIA file in the archive you have to select any member of the

archive and press the Modify non CATIA archive content icon % . You will get the
dialog shown in Figure 68.

Modify non CATIA CMIArchive content ed B

Marme | Path | Status |

CMI-Archive file name:
| CiixmapiDEZ_Archive_Top.CMIArchive

add non CATIA files | Remove non caTis fies |

| @ cancel l

Figure 68: Modify non CATIA CMI Archive content
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To add some files press the “Add non CATIA files” button of the dialog. A second
dialog appears. This dialog shows all files of the CMI exchange directory expect the
loaded CMI product structure files and other CATIA files. To show non CMI CATIA
files you can deselect the filter checkbox.

Select the files you want to add to the Archive and press OK. The selected files are
added to the CMI archive. During CMI Update the files are packed to the archive file.
During read the files are extracted form the archive.

It is also possible to select a file in the dialog and to remove it from the archive by
pressing “Remove non CATIA files”. During CMI Update the files are removed from
the archive file.
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Handling of CATAnalysis
The CATIA V5 data type CATAnalysis can be stored in a CMI Archive (see Handling of
CMI Archives).

Read an existing product structure document (see Figure 69) to CATIA V5 (see
Y? Figure 70).

=

File Edit Tools wWindow Help

|aEaIRE | R D TEAMCENTER

Search

I Enter Ikem ID o s -
 Quick 3

Links Custaomize
B Home EA
B My Wiorklist »
|21 My Saved Searche 3
@ My Links »
(I —

* Open Ikems

rf CMIRII

{ii} My Teamcenter

Structure Manager
Y | —]

L |

Ready

Figure 69: Existing item in Teamcenter

[%]CATIA ¥5 - [CMI - D0D161.CATProduct] -0 x|
- 1= =

n Start  File Edit  Wew Insert  Tools CMI  Analvze  Window  Help
&

| LG E LS LEAEBALI L LS

Negaypzoew we BA88 /s 7.,
| o | 5y

Select an object ar a command

Figure 70: Item loaded by CMI

- Attach an existing CATAnalysis file with the CATIA V5 functionality Add existing
; component (see Figure 71).
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EJ start  Ble  Edt  view Insert  Tools  CMI pnalvee  window  Help =1

| LB B LAEAEBALBTELEE

_t
Se+005

Ne@ayhaoee 2 e B el suE 2.

1 element selected | 5' | g |
Figure 71: CMI Product with existing CATAnalysis

Select the Analysis in the product structure and use the Attach Archive function (see
Handling of CMI Archives).

The result is a new CMI Archive with the CATAnalysis file, CATProducts, CATParts,
and the optional CATAnalysisResults file, which is attached to the existing Item.
Figure 72 shows the item with the new CMI Archive attached.

My Teamcenter (2007) - Teamcenter 8 =0l x|
File Edit ‘iew Translation CMI-RII Tools ‘Window Help

R BGE(* | EesSE 8 aln]| - TEAMCENTER

My Teamcenter (2007) [ alexander Staudinger (a

) - Engineeting/Designer  [IMC-5164571/%¥

search 0 My Teamcenter (2007) &5

IEnter Ttem ID tos - | = ooo161/81 ®

~ Quick Custamize | || ) Folders x || Glooo161.1/a o Vewer ¥
Links I p——
#y ooo1e1
B Home » 27 00161 conent Name: 61 172 j
@My worklist » [ D00LELjA; 1 Date Created: | oo o000 120s ]

My Projects »
¥ 1y Links » - Formats [Eriany

2 |
£y Saved Searche 3 Group Iy &5 Enginesring

4 3
I _I _I Is Modifiable: @ True ¢ False
,j' CMI RII

i1l My Teamcenter

Structure Manager Check-Out and Edit |
g« Ds > B9
Ready .?x%dﬁmﬁd_fi

Figure 72: CATIA Workbench after Expand model on Part Number

The newly created CMI Archive can be opened with the CMI RII application (see
Figure 73) and loaded to CATIA with the Read command.
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Figure 73: CMI RIl application with CMI Archive

The result is the CATAnalysis document in CATIA V5 (see Figure 74).

[%]CATIA ¥5 - [CMI Archive - Analysis] =10 x|
EJ st Ele Edi Wiew Insert  Tools  CMI Window  Help == x|

| £ G855 LA AR ERT 5545

ra AT &)
DoSoRE
&ry},; R

| v

~p00pe s &

b

3

Ne@asprsow LS B8 'nm 2.,
Von Mises stress {nodal values). 1/Static Case Solution, l,l’ﬂ o | (3 | |

Figure 74: Existing CMI Archive with CATAnalysis loaded by CMI

Ny

. Changes made by the user can be updated with the standard CMI Update
i commands.
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I
Handling of Design Tables

CATIA V5 Design Tables o can be stored in Teamcenter. Both CSV and Excel™ files are
supported. The Design Table dataset is linked to the Item Revision and to the CATPart.
Design tables referenced by CATParts and CATProducts are supported.

Design tables are not stored by default because of performance considerations; also, you
need a sound methodology if you allow the use of design tables in your methodology,
since design tables have the power to change your product structures.

- : The Teamcenter administrator needs to set CMIWorkWithDesignTables to 1 in
“the Teamcenter preferences in order to enable the Design Table support.

A iThe CATIA administrator needs to set CMI_USE_DTFORPRODUCT=0N in the CATIA -
Zenvironment in order to enable the support of Design Tables and CATProducts. 3

A “To display the Design Tables in the CATIA structure the relation setting shown in

- Figure 75 must be set.

options 2=l

& |-T Options General | Display I Fart Document |

=Bl Gereral

I ) pisplay

- 38 Compatibiity

IB% par ameters and Measure
—'fﬁ Devices and Virtual Realit
v.InFrastructure

—m Product Struckure

- material Library

- [ Catalog Editor

I~ € Pert Infrastricture

[~ DELMIA Infrastructure
-:{,_F;{ 30 Annokations Infrastre
L B Collsbior stior, I sstruct
.- Mechanical Design

&8 Assembly Design

Display In Specification Tree
4 External References
[] Constraints
[] Parameters

& Relations |
Displays the relations created
using the Formula command.

Display In Geometry Area

4 Bodies

4 Expanc creation

[ ©nly the current operated salid

] Orly current bady
[ Geometry located after the current Feature

[] Parameters of Features and constraints

fuds system display size in mm)
Checking Operation When Renaming

# fo name check

(2 Under the same tres nods

) In the main ohject

ﬁ & ciether
I |
- @ oK 3 Cancel |

Figure 75: CATIA setting for displaying relations in the structure tree

Create Design Table
ii-) For this use case an Item was loaded from Teamcenter to CATIA. Then a Design
==

Table was added to the CATPart with the CATIA Design Table command ﬁ
Figure 76 shows the CATPart with the Design Table.
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nStart File Edit View Insert Tools CMI  Window  Help & x|
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DesignTable.1/Relations 000060 selected 5[

Figure 76: CATPart with Design Table

- In CATIA use the CMI Synchronize command. The Dialog shown in Figure 77 will
; show that the newly created Design Table will be created in Teamcenter.

CMI Synchronize Teamcenter =] 3

Operatian List

ot Opm] | el e — Graicien |
000060 000060 CATPart (BOM)  Update | Link

Edit PO Part Cabeaoy., I Inifi l Szn(hmnlz& l Close: I

ukpUE window

Single step mode

Figure 77: Synchronize dialog with create Design Table operation
. The Design Table is created in Teamcenter and linked to the CATPart. Figure 78
i shows the result from Teamcenter.

CMI Synchronize Teamcenter i [s] JE3

Operatian List

Next Op | Part Number [ Momenclature | Categor: [ Operation [ Exetute Result |
DesignTablel bxt DesignTable. 1 DesignTable Create Succeeded
Q0o0s0 000o&0 CATPart (BOM)  Update [ Link .. \‘ Succeeded
Edit EDIPart cateacty.. I Info I Synchronize I Clase I
Output window
< DesignTablel,bxt DesignTable: Create > =
CMIDesignTable Dataset 000060.1/4 created.
File 000060, 1.kxt For Dataset 000060.1/4 uploaded.
CMIDesignTable Dataset 000060.1/4 attached ta Item D0D0DG0/A;1, _I

Single step mode:

Figure 78: Synchronize dialog with creation result from Teamcenter

E) Figure 79 shows the result in Teamcenter. The Design Table dataset is created and
. added to the Item Revision.
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Figure 79: Design Table object in Teamcenter

Update Design Table

- The Design Table can be changed in CATIA with a double click on the Design Table
; object. The dialog shown in Figure 80 will be opened.

DesignTable.1 active, configuration row : 1 x|

lame : IDEs\gnTah\e.l S Activity

’7Des\gn Table Properties
M

Comment :I DesignTable created by bc2007 117112009

Configurations | associations |
S Fiter ;| Edi... |

Line | PartEDdiiPad‘liSkEtchliRad\us‘SiRad\us

(Edt toble ] [ Duplicate data in CATIA model

@ ok | @ apply | @ cancel |

Figure 80: Edit Design Table dialog in CATIA

Y With the Edit table ... button an editor with the Design Table file is opened (see
; Figure 81). The radius is changed from 15 to 12.5 mm and the file is saved and the
editor is closed.

Il
File Edt Format Wiew Help
PartBodyhPad. 1hsketch.1NRadius. ShRadius (mm) ;'
12.5

>
i .z

Figure 81: Opened Design Table file

CATIA will present the Knowledge Report (see Figure 82).

56 CMI RII User Manual



Knowledge Report o ] 3

DesignTable. |
DesignTable. 1

/| | |

The file of the: design table DesignTable-1 has been modifed.
This design table has been synchroniasd with this Fis

e

Figure 82: Knowledge Report in CATIA

- The geometry of the hole is updated. Next the Update Teamcenter command is
; pressed in CATIA (see Figure 83).

[#]CATIA ¥5 - [CMI - 000060] (=] 3]
EJ stat  File  Edit  Wiew Insert Tools  CMI Window  Help == x|

54

BHs LB CRALT T £ 58

RARRALEANSEBR!
oRe@0s Bl el

- r
LEBaxne0 R 6L BEY 9T 2.
DesignTable. L [Relationsf000060 selected [ J=il | = |

Figure 83: Changed Geometry in CATIA

- CMI RII will update the changed CATPart and Design Table file to Teamcenter and
; will show the success dialog (see Figure 84).

(CMI Warnings | CMI Information |

CMI3DGen Dataset 000060/A updated.

Fils 000060, CATPart For Datasst 0000604 uploaded.
File 000060, CATPart.car For Dataset 000060/4 uploaded.
(CMIDesignTable Dataset 000080.1 /4 updated.

File 000060, 1.txk For Dataset 000060.1/4 uploaded.

"CMI Operation Status

Update finished

Figure 84: Success message from Teamcenter

Remove Design Table

- The Design Table can be removed in CATIA. Figure 85 will show the CATPart
; without the Design Table.

CMI RII User Manual



[%]CATIA ¥5 - [CMI - 000060] i [=] 4]
EJ Stat  Fl= Edt  Wew Insert  Tools CMI Window Help =18 |

| £ 8B 657 LEALS RS ERE LGS

RDADREANS D!

SReQe Bl el

NeEgayraac R e B el vl 2,

Select an ohiect or a command [ =1 |

Figure 85: CATPart without Design Table

After pressing the Synchronize command the Synchronize dialog is shown. The
selected line shows the operation “Update/Drop child”. With the Info command the
information for the deleted children will be displayed.

CMI Synchronize Teamcenter =101 x|

Operation List

flext Op | Part Nurber Iomenclature Categor Operation Execute | Result

CATPart (BOM)  Update [ Drop... ¥

Information [000060] 2l x]

Update [ Drop child CATPart {(BOM) [000060]
Deleted chidren:
000060, 1.bxt ()

Edit POM:Part catzaory, Info ] Synchronize I Close I

Output window

Single step mode:

Figure 86: Synchronize dialog before Drop operation

The Synchronize command will remove the link from the CATPart (see Figure 87).
The Design Table object is not removed from the item. The user has to check the
status and if the Design Table dataset is not longer needed it can be removed in
Teamcenter by the user.

T
Operation List
Next Op | Part humber [ Momenclature | Categor [ operation [ Execute [ Result |
[hGEN) Q00060 CATPart (BOM)  Update f Drop... ¥ Succeeded
Edit PO Part cateaory,. I byli) I Synchronize I Clase I
Output window
CMI3DGen Datasst OOD0G0)A updated. |
File 000060, CATPart for Dataset 000060/4 uploaded.
File 000060, CATPart, cor For Dataset D00060/4 uploaded. J
Remaoved Design Table 000060, 1.txt From O00060/4,
The design table was not deleted, please check the status in POM, ;I
Single skep mode

Figure 87: Success dialog from Teamcenter
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Support of CATIA V5 Released Cache

CMI supports the use of cgr files in the released cache of CATIA V5. For this purpose the
cgr files of CATIA models are stored in Teamcenter. During To CATIA these cgr files are
copied to the released cache instead of the CATIA models to the exchange map. In
CATIA V5 the cgr files are loaded in visualization mode.

Use Edit2Options to set the CMI RIl preferences.
Set “Transfer CGR-File to CATIA V5" to “Only CGR” or “CGR + geometry”

&

Use Tools 2Options to set the preferences in CATIA V5.
Set “Work with the Cache System” to “ON” and set the path to the released cache.
“Check timestamps” must be “ON”.

h{.T cptions Cache Management | Cor Management | ENOVIAvpm | MNodes Customization | ProductStructure [P [

Cache Activation
-8l Display =i Work with the cache system
I8 compatibilty

7~ B General

Cache Location

IR Parameters and Measure Pathlo thelocal 212 [ pocuments and Settngs \idiuse o =] 2,
L& Devices and Virtual Reality Path to the released cache [CrReleasedCache @
Il nfrastructure
[~ i Product Structure. i |
sl Configure. .,
B taterial Library
Il Catalog Editor Cachesize

& Check Maximum size

I Phota Studio Maximum size 500 ME

% Real Time Rendering

| & Part Infrastructure nesarn

3 Check tmestamps
[1GMT tmestamp format

|- DELMIA Infrastructure

82130 Annatations Infrastruckure
L B Collaboration Infrastructure
& Mechanical Design

& o Shepe

-4 analysis & simulation

AEC Plant

Mathining
¢-@ Digital Mockup

Bl
- @ ok | @cancel]
Figure 88: Tools-> Options dialog in CATIA
A ’T’H’e’s’é’é’r’e’ the necessary preconditions to copy a cgr file:

e Work with the cache system in CATIA V5 is enabled.

e The released cache is set and exists.

e The CATIA V5 configuration variable CM1 _USERELEASEDCACHE is set to
“ON".

e The CMI RII preference “Transfer CGR-File to CATIA V5" is set to “Only
CGR” or “CGR i geometry”

If the CATIA V5 configuration variable CM1_SAVEADDITIONALCGR=ON is set, CMI
‘?' RII stores a cgr file in Teamcenter whenever a CATPart is created/updated.

Optional commands

In the following section, optional commands are described which must be enabled by the
administrator.
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Update Position

Update Parts

Restore Positions

.

’I
=y

: To enable this function the administrator has to set the CATIA V5 environment
“CMI_ENABLE_CMIUPDATEPOSITIONCMD=0N.

- This function updates only the transformation matrices in Teamcenter. The
“CATProduct and CATPart files are not updated.

: To get this function the administrator has to set the CATIA V5 environment
:CMI_ENABLE_CMIUPDATEPARTCMD=0ON.

- This function updates all modified CATPart files in Teamcenter. Transformations and
- CATProduct files are not updated. :

“ To enable this function the administrator has to set the CATIA V5 environment
:CMI_RESTORE_POSITION=ON.
- This function restores the positions to their original state loaded from Teamcenter.

“To get this function the administrator has to set the CATIA V5 environment
“CMI1_ENABLE_UPDATEPOSIT10NDIALOG=0ON.
- This function is available for normal Update and the Update Position command.

Choose Update Options 1 ed x|

Model Update | Matrix Update |

Part Number Parent Instance MName

0015?9 Screw. 1 000752
Yas 001579 Screw.4 ooovsz
s 000790 ConnectionRodMadel. 1 001593

Toggle update state |

@ oK I JCanceII

Figure 89: Choose Matrix To Update dialog

If you have changed some positions in the CATIA session this function allows you
to select the matrices to be updated. If you select a line in the dialog the
corresponding instance will be highlighted in the CATIA structure tree.

e Yes > Matrix will be updated in Teamcenter

e No - Matrix will stay unchanged in Teamcenter
To change the state you can double click a line or select the line and press the
Toggle update state button.
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Choose Update Geometry

!~ :To get this function the administrator has to set the CATIA V5 environment
' :CMI_ENABLE_UPD_MODELSELECT_DIALOG=ON.
“This function is available for normal Update and the Update Parts command.

Choose Update Options ol 2 x|
Maodel Update | Matrix Update |
I Update I Part Nurnber I File Mame |
‘fes 000776 000776, CATPAark
001575 001575, CATPark
es Qo177 001577, CATPark
‘es 001583 0015535, CATPark
es 001585 001585, CATPark
es oo1sEe 001939, CATPark
‘es 001593 0015935, CATPark
es 001595 001595, CATPark
es 01597 001597, CATPark
‘fes 001599 001599, CATPark
Toggls update state I
@ oK I ' Cancel I
-

Figure 90: Choose Model To Update dialog

If you have changed some geometries in the CATIA session this function allows you
‘? to select the models to be updated.
e Yes - Model will be updated in Teamcenter
e No - Model will stay unchanged in Teamcenter
To change the state you can double click a line or select the line and press the
Toggle update state button.

Check In/Check Out
e
'~ To get this function the administrator has to set the CATIA V5 environment -

:CMI1_ENABLE_CMICHECKINOUTCMD=0ON.
*This function is used to check in and check out datasets from the CATIA V5.
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Select Files to change read only state

TC-State | Modified | Filename | Result |
E Mo Access YES  MyProd11.CATProduct

& Check In possible B ves MyProd12, CATProduct

g Check Out possible B no MyProd13.CATProduct

g8 Revise possible B ves MyProd 10, CATProduct

Fetched info from Teamcenter

Refresh from TC I Check In I Check Out ] Revise I

Close l

Figure 91: Check In/Check Out dialog

The dialog shows the following:

= TC-State
Shows the check in/check out, revise state of the dataset in Teamcenter.
=  Modified
Shows the modification state in CATIA.
=  Filename
Shows the filename.
=  Result
Shows the result for the last action for the file.

The following actions are possible:

= Refresh from TC
Refresh the information from Teamcenter.
= Check In/Check Out
Before performing the Check In/Check Out action, the user has to select the files
to be checked in/checked out.
= Revise (see section Dataset pseudo Revise)
Before performing the Revise action, the user has to select the files to be revised.
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Dataset pseudo Revise

CMI RII supports the standard Teamcenter behavior for the revise process. That means
when an Item Revision is going to be revised the CAD Datasets belonging to can be
referenced by the new revision of the Item Revision (‘Copy As Reference’) or copied
(‘Copy As Object’). With “Copy As Reference” the Dataset is write protected.

In order to be able to modify the CAD Datasets in CATIA the CAD Dataset must be
“pseudo Revised”. Though, a revise is only possible under certain conditions:

e The CAD Dataset is referenced by a predecessor of the current Item Revision.

e The Item Revision B has “working” state and the user has write access to the
Item Revision.

o If the CAD Dataset has “working” state a revise of the dataset is not required and
will not be offered therefore.

e Only primary CAD Datasets can be revised: CMI3DGeo, CMIAux3DGeo,
CMIStructure or CMI2DGeo.

e Only CAD Datasets that are attached to an Item/Part can be revised.

If these conditions are true then:

Creation of a new CAD Dataset /B.

Copy of the named Reference (the CATPart) from the CAD Dataset /A.
Copy of attributes from CAD Dataset /A.

Removal of Relationship between Item Revision /B and CAD Dataset /A.
The CAD Dataset /B will be attached to Item Revision /B.

Optionally (with CMI preference setting): Automatic Check Out of the new
Dataset revision.

“ ltemRevA Y‘f’ x— % ltem RevB % Item RevB
8 3) Delet
4 Data Set A ﬁ”—%g,aﬁoi:hip L ., Data Set B

I—;;ﬁ ltem ID.CATPart I—gﬁ ltem ID.CATPart

(2) Create of
Relationship

(1) Copy
iy Data SetB

I—ﬂ ltem ID.CATPart

Figure 92: General Process of “Pseudo Revise” for CAD Datasets
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Glossary

Administrator

Person, who configures the system, inserts users, manages user permissions and
maintains the database.

Browser
Window that displays icons representing objects.
Check In
Action that takes from the users the right to update a work item.
Check Out
Action that gives the user the exclusive right to update a work item. Checking out an item
creates a copy of the work item in the specified work location.
Configuration Context
An attribute that determines which Item Revision should be displayed (for example, only
the last revisions).
Dialog Window
Window in which the user enters information.
Feld
Component of a dialog window in which the user can enter text.
Generic Workbench
Set of components such as windows, dynamic items and information items, used in
Teamcenter integration products.
Icon
Graphical representation of an object.
List View
Style of browser window in which objects are viewed as small icons in a list with attribute
values in columns.
Object
An item or relationship.
Palette

Any group of CATIA functions created for specific requirements.
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Plot Fle

Pop-Up Menu

Query

Register

Tree View

Vault

File in a specified format that can be plotted or opened in a viewing tool and represents a
2D view of a model.

The menu that appears when the user points an icon and holds the right mouse button
pressed.

To search the database for objects that match specific criteria.

To make a file or directory known as an object maintained in the Teamcenter database.

Style of browser window in which objects are displayed as relationships in horizontal
branches.

Secure place for storing information. To access the data confined in a vault it is necessary
to check out or revise the data.
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